Table of Contents

IBM Business Process Management Journal

Issue 3 : January 20, 2011

From the editor

The IBM Business Process Management Journal is dedicated to providing both business and IT professionals with the latest news about IBM business process management tools and technologies.
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Introduction

To some business-oriented people, business process management (BPM) is synonymous with workflow or modeling: documenting the processes operated by the business and using this for reference purposes and possibly to design improvements. At the other end of the spectrum, to some technical people BPM is synonymous with process automation: identifying the steps in the process that can be automated, and implementing information technology (IT) functions or “services” to automate these tasks. Although both of these approaches have value, neither addresses BPM holistically; so neither approach obtains the full value of BPM. BPM is not just workflow, nor is it just process automation.

Today, organizations embark on the BPM journey because they need business agility. They need the ability to respond quickly to evolving customer demands or environmental threats with new products and services and to enable planned changes to their business strategies quickly. They need the agility to expand quickly or to restrict their networks of business partners. In this context, BPM can be a business agility enabler; and as such, a BPM implementation may include the following capabilities in some shape or form: modeling, simulation, workflow, business rules, business data, business analytics, collaboration, human interfaces, business events, business activity monitoring, content, compliance, security, and system integration. Figure 1 illustrates BPM users (for example, business analyst, manager) using a role-based view to interact with the BPM platform, which provides required capabilities (for example, business rules, workflow).


Figure 1. BPM capabilities
BPM capabilities

BPM initiatives and the resulting BPM solutions are comprehensive. Does that mean the barrier to entry is high? Does that mean you need experts in each one of these capability areas to get started? Absolutely not! In fact, one of the key premises of BPM is that it is easy to begin a project simply and to gradually evolve your BPM capabilities.

This article describes best practices for BPM adoption and expansion using IBM BPM products as example enablers. Drawn from thousands of IBM’s BPM customer engagements, these practices are customizable to an organization's specific needs and can be used to start or expand BPM initiatives. They can be categorized according to three adoption scenarios: Business-Led Discovery, Interaction and Collaboration, and Continuous Process Optimization. These adoption scenarios are not an official list and are not mutually exclusive.

 

 

Business-Led Discovery

The Business-Led Discovery adoption scenario begins with identification of the focus business areas. For example, a bank may find that prequalification is inflexible in account opening processes; a telecommunications business may require better marketing and sales campaign management with targeted offers; a government educationtime agency may need to optimize issuance and management of teacher licenses. Selecting the right business areas requires consideration of business opportunities, costs, pain points, and compliance requirements.

Business-Led Discovery involves process discovery, which is about understanding how the target business operates today (the “as-is” state) and, more importantly, how the business should operate tomorrow (the “to-be” state). Considerations include:

  • How long it takes to complete each task
  • How much it costs
  • What information flows back and forth (including paper documents, faxes, and so on)
  • Who participates in the business process (roles)
  • What information channels participants use (for example, email, phone call, web portal, and so on)
  • What back-end systems (applications) support the business process

When performing process discovery, an industry-specific approach significantly improves the time to value (TTV). For example, it's useful to review industry benchmarks for the target processes to document comparisons with competitor operations or industry norms (for example, time it takes to on-board a customer, number of fraudulent declarations for a revenue agency, and so on). Key performance indicators (KPIs) and industry-specific assets such as process diagrams provide validated starting points for process modeling. For example, an organization can begin with a typical Banking Account Opening business process model created using WebSphere Business Modeler (instead of a blank sheet of paper or blank screen) and a roster of industry-specific KPIs already documented from which to select. These software assets are included in the WebSphere Industry Content Pack for Banking (see Resources), together with other industry-specific and industry-agnostic assets).

Modeling is used to understand and document business processes (in both as-is and to-be states). The modeling tools should be user-friendly offerings (small footprint, minimal configuration requirements, and designed for non-IT business users) and at the same time provide the required modeling capabilities. Documentation tools such as Microsoft® Visio® enable creation of visual documents in a familiar form but are not appropriate BPM modeling tools, even with BPM plug-ins. These tools simply store visuals and lack true modeling tools capabilities (supported by underlying modeling frameworks and meta-models). Their resulting artifacts are digital “dead-ends,” which require import to other software tools to create working software code, or to do detailed process analysis. IBM BlueWorks Live, shown in Figure 2, WebSphere Business Modeler or WebSphere Lombardi Edition's Designer, on the other hand, are full-fledged modeling tools that provide industry-standard constructs such as Business Process Modeling Notation (BPMN). This capability is critical to support a proven model-driven development (MDD) approach. These tools enable both business and technical users to design and build process models, which can be analyzed, optimized, and converted directly into implementation code.


Figure 2. A business process model in IBM BlueWorks Live
A business                                         process model in IBM BlueWorks Live

 

 

Some full-function modeling tools also provide process simulation -- the running of “what if?” scenarios to optimize process models during discovery. Simulation allows you to experiment, evaluate alternate approaches and capture valuable insights with minimal effort and no negative impact on the business or the production environment. Similarly, if an industry-leading business rules management system (BRMS) such as IBM’s WebSphere ILOG® JRules is used, the effect of modifications to business rules can be demonstrated before they are applied. For example, if an educator certification’s testing and credentialing process includes a rule requiring an educator to be twenty-one instead of eighteen years of age, then it will be possible to determine how many educators with certification applications in progress will be affected by this change. I'll talk more about the relationship between business rules and business processes in Continuous Process Optimization.

Process improvement fits into this adoption scenario of Business-Led Discovery too, as represented by the Lean, Six Sigma, Lean Six Sigma and Business Process Re-Engineering methods. The goal of these initiatives is to discover and model business processes in order to improve them. WebSphere Business Modeler is an effective modeling tool supporting process improvement initiatives. Note that improving business processes may or may not involve BPM IT implementation. For example, analysis may reveal that a case worker wastes more than two hours every week because of the time it takes to walk to the FAX machine. In this case, the improvement recommendation should be to position the FAX machine closer to the worker’s work station. However, most effective and modern process improvements do require the automation of key steps using a BPM software suite, as I'll discuss in Continuous Process Optimization.

The most cost-effective business process modeling introduction will facilitate relatively simple and rapid experience and evaluation of the BPM platform, providing a short TTV in contrast with the time-consuming request for proposal (RFP) or technical proof of concept (PoC) activities. In addition, the users typically involved in these procurement activities are not technical, but it is desireable for these non-technical people to participate and follow best practices in BPM IT product evaluations. For these reasons, BPM via a Cloud delivery model such as IBM’s BlueWorks Live is ideal. Leveraging the public cloud eliminates dependency on the evaluating organization’s IT department for the procurement or deployment of the software – the only required end-user software is a Web browser that typically is already installed on the end users’ personal computers or laptops.

The Business-Led Discovery adoption scenario facilitates understanding of how the business operates and how improvements to the business processes can affect the “bottom line.” A natural next step (or a different starting point) in a successful implementation is to make newly designed best business practices (that is, the processes modeled using a BPM modeling tool) operational and to ensure collaboration by having people in the whole organization participate. This is where the Interaction and Collaboration adoption scenario applies.

 

 

Interaction and Collaboration

This section covers the collaboration aspects of BPM as well as a closely related concept called Advanced Case Management.

A critical success factor for BPM is collaboration. Participants should be able to interact when needed during the discovery, implementation, and execution of a business process. Workshops and meetings are essential for users from different and, particularly, physically or geographically dispersed departments to participate and collaborate meaningfully and efficiently to get the process right. In this way, the collaboration audit trail (for example, discussions, reviews, comments, or approvals) can be linked to the model of the business process instead of being buried in the participants’ emails or in hard-copy files. Participants can be empowered to make approval decisions and can be notified when they have to make decisions or take other actions; and activity audit trails can be maintained automatically for greater completeness, accuracy and timeliness with virtually no extra effort expended by participants.

We know that technical people are relatively good at using tools (for example, a designer using a Unified Modeling Language (UML) tool, or an IT operations professional using an IT service management tool). However, non-IT participants in the organization may be neither as skilled nor as comfortable using tools.

Ask yourself, what is the number one application in terms of frequency of use during the work day? Email! We use email to interact and collaborate. For example, a salesperson may require approval of a price discount, so she sends a note to the sales manager describing the opportunity. The manager replies asking for more information, and the salesperson provides it. The manager discusses the sales opportunity during the next cadence call and then forwards the email chain to the vice president of Sales, who finally approves it. One month later the salesperson needs another discount approval. What does she do? She sends an email, and the ad hoc discount approval process is repeated.

The problem with this approach is that, when using email or phone calls or both methods, the sales manager does not have a view of what discounts are pending or approved. The VP has no insight into what requests for approval are pending. The manager has no way of verifying quickly that all the required information has been provided.

What if this discount approval process could be quickly automated using BPM to provide a quick way of defining the required steps, which steps are approval steps, who has to perform each step, and when they are due? Whenever someone needed a sales discount approved, she could launch an instance of the discount approval process. The first step automatically goes to the right person, notifying her using the preferred method (for example, email or voicemail). Using this approach, the discount approval process can be standardized; and as a result:

  • Sales people precisely follow this process and do not miss steps by mistake (although steps can be skipped if required, as defined by the process model).
  • The manager gets a view of all discounts (pending or approved).
  • The VP knows what discounts will be given, pending approval.

IBM BlueWorks Live provides the ability to do just that -– to automate these simple processes that typically are performed using email (such as marketing campaign launch, presentation review and approval, meeting debrief and lessons learned, travel approval, laptop computer request). BPM supported by IBM BlueWorks Live allows everyone in the organization, including non-technical people, to collaborate in the execution of repeatable and predictable procedures. Please note that BlueWorks Live process automation does not apply to more complex processes, which require system integration, high scalability or high throughput (for example, Account Opening).

Figure 3 shows an example of a sales person launching an instance of the discount approval business process for their ACME opportunity: the “ACME discount approval process”. I used the template, attached documentation (in this case, an Excel® spreadsheet) to the process instance, assigned steps to people (myself, my manager, and my VP), and set due dates before launching the business process instance.


Figure 3. Process automation in IBM BlueWorks Live
Process automation in IBM BlueWorks Live

To apply the Interaction and Collaboration adoption scenario, a low barrier to entry and a significant number of business user participants are needed. These factors make an internet-accessible offering attractive.

Which social networking application do you use to keep in touch with friends and family, to know what is happening around you? Facebook? Twitter? Consider then the ability to apply the idea of social networking to BPM and have “social BPM"? Wouldn’t it be helpful to be connected to BPM thought leaders and corporate colleagues concurrently but separately, to preserve confidentiality of corporate matters and to receive the right feeds, at the right time to support and perform our required work? IBM BlueWorks Live provides a public BPM collaboration blog stream, concurrent and coexistent with a private (enterprise) feed, supporting the need for “social BPM” in a discrete and convenient manner, as shown in Figure 4. IBM BlueWorks Live is delivered using a Software-As-A-Service (SAAS) model and it includes built-in security and access rights to support private collaboration between a group of individuals from the same organization.


Figure 4. IBM BlueWorks Live private and public communities
IBM BlueWorks Live                     private and public communities

 

 

A key enabler of BPM collaboration is the BPM user interface (UI) -- the face of BPM. Do not underestimate the importance of user experience, ease of use, and intuitiveness for the success of any BPM solution. As previously mentioned, most of the business processes that occur on a daily basis involve human interaction; so there must be a tight linkage between the UI and the rest of the BPM solution. IBM’s WebSphere Lombardi Edition was created with this principle in mind. A complete BPM solution, Lombardi provides the ability to define electronic forms and the flows between these forms as the business process progresses. In Lombardi, these forms are called Coaches, as shown in Figure 5.


Figure 5. A WebSphere Lombardi Edition Coach
A WebSphere Lombardi Edition Coach

 

 

I've worked with customers who standardized on a user interface (for example, enterprise-wide portal, enterprise-wide technology for electronic forms). From the experience I've gained from this approach, it's clear to me that although perhaps not for the initial proof of concept, a successful BPM implementation must be compatible with this environment. For example, BPM-related widgets and forms must be compatible with the portal technology. Role-based dashboards have proven to be very successful, because they enable business users to access the right information at the right time, when decisions must be made. This principle will be discussed in greater detail in Advanced Case Management and BPM.

Tasks that can't be automated by an IT-provided function (for example, by a service or by a business rule) are referred to as human tasks. They require human-to-human or human-to-system interaction. For tasks such as these, designers should think about exceptions from the outset of the project. For example, what happens if a manager is on vacation? Can the approval step be omitted for this instance only? Human tasks and exception management are critical to the success of a BPM implementation and you should confirm that the selected BPM platform supports them. For example, WebSphere Dynamic Process Edition provides the ability to reassign tasks automatically (based on a timer) or manually at runtime for a live process.

Advanced Case Management and BPM

Advanced Case Management (or Dynamic Case Management) is about the evolution of document-centric BPM offerings to a more comprehensive solution, which encompasses Enterprise Content Management (ECM), content analytics, collaboration and social software, business rules, and BPM. The idea behind Advanced Case Management (ACM) is that separate offerings for each of these capabilities, even if integrated together for a solution, would not meet the needs of "cases," thus requiring a new comprehensive offering centered on the notion of a case and the knowledge worker.

A case can be anything people used to keep in a physical folder and the processes or procedures they followed in relation to this folder. For example, a case can be a patient's health record, an insurance claim, a benefits enrollment matter, or a credit card dispute. What is required is a complete 360-degree view of the case, as shown in Figure 6.


Figure 6. Advanced Case Management
Advanced Case Management

ACM makes sense when the experience of the knowledge worker (case worker) is paramount to an efficient and optimal outcome of a case resolution. ACM involves business processes and requires extensive handling of documentation (such as paper forms, resumes, authorizations, transcripts), strict governance and compliance (including audit trails), advanced case analytics and reporting, and collaboration between people working on the cases. With a BPM application, the business process is at the core of the solution, with an ACM application, the knowledge worker and the case are at the core of the solution.

Please note that most of the best practices described in other sections (discovery, modeling, collaboration, automation, robustness, and so on) apply to ACM.

As with BPM projects, industry-specific knowledge and having a pre-defined starting point, or case template, significantly abbreviates time-to-value for an ACM implementation. Case templates capture best practices from specific industries and business areas (for example, a case template for teacher licensure, auto insurance claim, individual banking account, or mortgage application).

IBM's ACM offering, Case Manager, provides the ability to rapidly design the case application, starting from case templates or building the case in interview mode. The case solution definition allows for the creation of artifacts such as tasks (business processes) pertinent to the case, document types, roles, and case types, all of which enable access to extensive information related to the case (business intelligence) and enables documenting compliance related to the case. Additionally, IBM Case Manager allows for the creation of ad-hoc tasks or processes needed to resolve a case.

A key component of an ACM-based solution is the user interface. Making sure the UI is relevant and intuitive for case workers is important. Role-based dashboards work very well in this context, providing access to the right case information at the right time, and allowing collaboration and interaction with other workers. Leveraging modern UI technologies, such as widgets and mashups allows for the required customization.


Figure 7. Capabilities of Case Manager, IBM's Advanced Case Management (ACM) solution
Capabilities of Case Manager

I've worked with customers who had the option to reduce (or to eliminate entirely) the number of paper documents related to business processes; thus enabling improved accuracy, decreased cost, and quicker processing time. This approach is supported by electronic forms solutions such as IBM Forms. An electronic form can be visually identical to its paper counterpart.

There are many integration points or similarities between enterprise content management (ECM) and BPM. The core ideas behind these linkages are to make your content process-aware and your process content-aware. Recent improvements have been made in this area, such as the WebSphere Adapters for ECM. For example, for a life insurance application, you may require three documents from the applicant: physical exam results, credit report, and a signed application. You can design your solution so that, once all three documents are received, it automatically initiates an underwriting process. Then later during the underwriting process, the underwriter has access to all three documents when she receives a business task to work on from her dashboard. Figure 8 shows how IBM Case Manager provides access to case-related documents.


Figure 8. Document management and BPM in IBM Case Manager
Document management and BPM in IBM Case Manager

 

 

Continuous Process Optimization

The Continuous Process Optimization adoption scenario is very extensive. In fact, continuous process optimization can also be seen as the overarching goal supported by the other BPM activities (discovery, modeling, automation, and so on). Continuous process optimization involves continuously managing and monitoring your business processes, designing improvements and automating process steps using a BPM solution that is both robust and flexible. In this section, I'll touch on the following aspects of continuous process optimization:

  • Business activity monitoring
  • Process automation
  • Business rules
  • Business events

Business activity monitoring

Business activity monitoring (BAM) enables business users to get a real-time view of what is happening in the organization, from operational data, such as how many loan origination processes are in progress or what the workload is for a given case worker, to more advanced business analytics like predicting customer demand trends. We sometimes refer to this topic as “visibility and control.” For some organizations, looking at this at the beginning as an entry point makes sense. For example, you want to understand how many loan applications you actually process every week (as opposed to how many you think you process), you want to know how long it takes to approve a client for a new product, and whether and why specific products require more processing time. You do this because you want to take action based on what you see, such as reassigning tasks among case workers or training customer sales representatives on a new process that was a bottleneck, or automating parts of the process. For other organizations who spent time and effort modeling and automating business processes, it makes sense to use BAM to provide visibility and control onto these automated business processes.

Business intelligence (BI) provides extensive data integration, dashboards, scorecards, analysis, and reporting. As such it is naturally linked to BAM and BPM. One way to look at it is that BAM gives you a view of operational data and what is happening, while BI gives you access to more extensive intelligence and historical analysis on why these things are happening. BI gives you the ability to get detailed and up-to-date reporting information, standardized across a role set in an organization or ad hoc, so that you can create new reports as needed. BI allows you to perform analysis to understand why things are the way they are (root cause analysis) as a basis for performing simulations to explore “what if?” scenarios to obtain process improvement and, ultimately, optimization.

How does BI relate to BPM then? We can look at it from two viewpoints:

  • What business intelligence do you need as you execute business processes?
  • Based on specific business intelligence, what processes should you initiate?

The first viewpoint is about improving decision making, making sure case workers have access to relevant information when they need it (for example, when they get assigned a task from a business process instance). With WebSphere Business Monitor (the BAM component) you have the ability to show Cognos (the BI component) reports as part of the BAM dashboard.

The second viewpoint is about responding quickly to business situations by automating and standardizing actions. For example, based on a specific event, Cognos can automatically invoke a process running on WebSphere Process Server, passing the relevant business data from Cognos. For more details on BI, see IBM Cognos in Resources.

Process automation

Process automation is a key component of your BPM implementation. Process automation provides quality and accuracy (by reducing the human factor the error rate decreases), speed of decision, and improved productivity (less user involvement means tasks take less time to complete). Process automation requires identifying the parts of the business process (the business functions) that can be automated. Once a business task has been automated as a service, then that service can be reused by other business processes, resulting in fewer resources to create or manage.

This is where Service Oriented Architecture (SOA) naturally applies. SOA initiatives typically include some level of process automation. A top-down SOA approach, decomposing business processes (level 1, level 2 sub-process, level 3 sub-sub-process) yields a granularity level that makes sense for an automated business function. The development of services to provide these functions is integral with process automation. IBM refers to this overall BPM-oriented approach as BPM powered by Smart SOA, which could not be more appropriate than in the context of process automation. The key steps are to identify the services that are required to automate the business process, to create a clear description and a stable interface for each service (including operations with signatures) and then to develop and manage these individual services' lifecycles, ensuring that the relation of each to the target business process is clearly described. For more information on identifying and implementing services, refer to Service Oriented Modeling and Architecture (SOMA) in Resources.

Most businesses have been supported by proven legacy systems: COBOL applications running on the mainframe, RPG applications running on iSeries, or distributed Java™ Enterprise Edition (JEE) or .NET applications running in a client-server or virtual IT environment. BPM projects do not operate in isolation and the BPM solution needs to somehow integrate with these existing systems. You'll need to make sure that you can leverage these existing systems (yours or your business partners') in your BPM solution. We sometimes refer to this domain as “connectivity” and it is important that your BPM platform can leverage connectivity capabilities. I'll talk more about this and how SOA helps in Architectural Considerations for the BPM solution. You need tools that allow you to do technical implementation of processes (such as Business Process Execution Language (BPEL)) and services and integrate with these backend systems. WebSphere Integration Developer is the tool that is used to implement BPEL, Service Component Architecture (SCA) components and mediations (mediations enable connectivity between consumers and providers).

Business rules

Business rules and BPM are related. I've seen many organizations who are currently business rules users and now want to do BPM, and vice versa. This is a good thing! Business rules are everywhere, deep inside your application code or simply in the minds of your subject matter experts. A business rules management system (BRMS) like WebSphere ILOG JRules allows you to centrally manage these rules, as shown in Figure 9.


Figure 9. WebSphere ILOG JRules: A BRMS
WebSphere ILOG JRules: A BRMS

Business rules are used to automate checklists, validations, routing, and more. Anything that can be expressed as a condition (if, then, else) can be a business rule. Figure 10 shows an example of a business rule related to a government agency (pensions). The beauty of business rules is that a non-technical business analyst (or a developer) can understand and modify them. Business rules are expressed in a natural language (English or other) and specific values in the rules can be modified (under strict governance and access control). For example, in the rule shown in Figure 10, a business analyst might be authorized to modify the value for Service Years from 10 to 12.


Figure 10. An example of a business rule
An example of a business rule

In the context of BPM, we refer to business rules as “decision services." At specific steps in the business process, we fire (execute) business rules and based on the result of the rules' execution we automatically make a decision about what to do next (what branch of the business process to go to). For example, as part of an Educator Certification business process, we can invoke a decision service (a business rule), which automatically determines whether the applicant meets the requirements to take the tests for his certification. If he does, then the process continues to the “testing branch” (where the educator takes tests). If not, based on what is missing, the process continues onto another branch (such as, background check for the applicant).

Business rules are an example of a business agility enabler, enabling a flexible BPM solution. Other flexibility aspects are important as well. For example, your BPM solution needs to be able to manage exceptions, give you the ability to modify in-flight process instances (without redeployment), such as example skipping steps or jumping backwards in a live process instance. This dynamic aspect of BPM is critical and at the core of WebSphere Dynamic Process Edition.

Business events

Business event processing (BEP), sometimes referred to as complex events processing (CEP), is closely aligned with the concept of BPM and business rules. My favorite BEP example is as follows (skip this if you know BEP!): Your credit card is used in a store in Toronto, Canada at 8AM EST. This is an event. Your credit card is used in a store in Tokyo, Japan at 8:01AM EST. This is another event. Individually, these events are not critical. But when you do some correlation based on BEP, you are able to detect potential fraud. There are other types of events. For example, looking at how many times one of your existing customers goes to your web site and looks at a product description for a product they have not yet ordered. After a few occurrences of this, you may want to contact the customer about the product and do forward marketing. Additionally business events can be generated by business processes themselves and you can also monitor the absence of events.

BEP detects events, or business situations, analyzes and correlates, and notifies people or systems to take action. The next question is: What must happen when a business event is detected? Imagine that you have the ability to automate the actions that must be taken in response to the event. For example, for your existing customer showing interest in a new product, you can automatically send her an email with a promotional offer immediately after she views the product description for the third time! Imagine that your implementation automatically invokes a business process or a business rule in response to an event being detected. This is exactly what is provided by IBM WebSphere Decision Server, which provides BEP and BRMS together, as shown in Figure 11.


Figure 11. WebSphere Decision Server - BEP and BRMS together
WebSphere Decision Server - BEP and BRMS together

 

 

Architectural considerations for the BPM solution

Your BPM implementation needs to support quality of service and non-functional requirements such as integrity, performance, scalability, availability, and security. To accomplish this, your BPM implementation should be built on a robust BPM platform. This is where architecture is paramount and I recommend that you engage with a strong architect who knows how to address your non-functional requirements using the BPM platform. For example, how do you ensure that your BPM-based solution is available 99% of the time? How do you ensure that the data used by the business processes is sound and secure end-to-end? How do you ensure that your solution can scale up (or down) as usage changes? Clearly these concerns are not new concerns and are not related to BPM only. IBM's answer to this need for support of non-functional requirements is to base the BPM platform on more foundational capabilities such as SOA or Infrastructure. We refer to this as BPM powered by Smart SOA (see Figure 12). Please refer to the articles on the synergies between BPM, SOA, and Enterprise Architecture in Resources for more detail on this.


Figure 12. BPM powered by Smart SOA (retail example
BPM powered by Smart SOA (retail example

SOA, as an architectural style, should always be used to support other IT initiatives (BPM and others). For example, the BPM-based solution can leverage the security and connectivity components of your service-oriented architecture. Let's think about the scalability requirement as an example: The IBM BPM products are built on top of WebSphere Application Server Network Deployment, which supports clustering, which thus enables a scalable solution implementation.

It's important to note that although the SOA style of software architecture and development is not required for BPM implementation, the two techniques in combination maximize not only agility but also software reuse, internal and external communication, and joint governance, including line-of-business and IT management and staff.

In general, you should get value by following proven practices and topologies such as the ones described in the WebSphere BPM V7 Production Topologies (see Resources).

Process integrity has always been at the core of the IBM BPM strategy. Process integrity is necessary to meet compliance and regulatory requirements. You must be sure that your processes run as designed. The challenge is that we're not talking about the integrity of an individual transaction (making sure the transaction happened once and only once). Rather, we're talking about the integrity of end-to-end business processes, which span multiple organizations and systems both internal and external, and can be running for very long periods of time, thus making mechanisms like compensation more complex. Compensation and consistency are key elements of process integrity, making sure that the system is at a point of consistency at any given point in time -- whether processes executed fully or whether processes could not complete and had to be rolled back. IBM BPM process integrity is achieved by specific BPM capabilities on top of the underlying platform which supports BPM: connectivity, messaging, security, and so on.

A BPM Center of Excellence (COE) is a key contributor to the success of BPM initiatives in the enterprise and across projects. A COE is important for BPM because the BPM method is different (in that it has interactions between business and IT, iterative and model-driven approach) and business processes typically span domains. The BPM COE will help ensure that everyone playing a role on BPM projects knows what he or she has to do differently and why they have to do it this way. The BPM COE sets standards and procedures to be followed by the different groups in the organization, transfers BPM knowledge to ongoing projects, and defines a governance model, including policies, processes, and metrics. Key activities related to setting up a BPM COE include defining the COE's mission, understanding the current BPM maturity, defining BPM roles and skills, and defining the COE structure an mechanisms. BPM COE recommendations need to be actionable; we are used to saying “The BPM COE needs to have teeth!” There is no point in defining standards and procedures if people do not adhere to or follow them, respectively. Metrics, incentive models, or other techniques help ensure the success of the BPM COE.

 

 

Conclusion

In this article, BPM implementation use cases were categorized and discussed by the following user adoption scenarios: Business-Led Discovery, Interaction and Collaboration, and Continuous Process Optimization. Understanding these scenarios enables organizations to focus on that aspect of BPM that is most applicable and advantageous for the implementing organization. As previously noted, these approaches are not mutually exclusive. For example, I have worked with a customer for whom the Business-Led Discovery scenario was critical (line-of-business users involved from the very beginning of the project with needs for standardized processes in order to expand the business to new countries); and also for whom Continuous Process Optimization was critical to support the ongoing business objectives (the IT application had to be leveraged to provide the functions required by business processes).

Adopting BPM involves a paradigm shift and entails using practices not often familiar to the implementing organization. BPM requires delivering value and implementing IT projects differently than traditional IT projects. Successful customers adopt an iterative development approach with frequent milestones and regular reviews including frequent collaboration among business and IT users. Adopting BPM may also involve skills not readily available. For example, experienced business analysts are often in short supply.

Nevertheless, organizations that have been successful with their BPM initiatives share common characteristics. First, they started to become familiar with BPM using low-risk and low-investment solutions such as IBM BlueWorks Live. Then, they performed analysis to understand their current maturity level (skills, platform, and so on) and also their appetite for BPM -- where they want to be, and how much effort they are ready to undertake. As a result, they were able to identify the initial process area on which to focus; thus providing value in that area while laying the foundation for their BPM capabilities using one or more of the adoption scenarios described in this article. But they did not stop after the first project! Instead they now have a blueprint and roadmap for how they're going to use projects to realize their BPM vision. Successful organizations were also very clear about what they could do themselves and where they needed help (for example, due to lack of in-house BPM skills, when it makes sense to engage a strategic partner like IBM).

There is a BPM solution that fits your organization's purpose, a BPM solution that provides the capabilities you require, such as business rules or document management, a BPM solution that you can effectively implement and deploy in your organization. The IBM process improvement discovery workshop is a complimentary 3-day workshop that looks at the applicability of BPM for your organization, evaluates the optimal starting point (for example, one of the scenarios described in this article), understands the business impact of the BPM initiative, and defines a baseline for the BPM solution architecture. In other words, the workshop defines your BPM “fit-for-purpose” solution baseline. For more detail on the workshop, see Resources.
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Introduction

BPMN, SCA, SOAML, WSDL, OSLC, TOGAF: we've all heard one of more of these acronyms that represent a multitude of existing or emerging standards that apply to the BPM and SOA spaces. Standards are an important part of establishing a common “trading language” for the modern enterprise, internally as well as externally. There are generally five types of standards that are important to a BPM practitioner:

  • Semantic standards such as the The Open Group SOA Ontology define common concepts and terms in support of effective communication and understanding.
  • Format standards such as BPMN 2.0, SOAML, SCA, RAS (Reusable Asset Specification) and OSLC support collaboration and consumability.
  • Framework standards such as TOGAF provide context and structure.
  • Industry model standards such as eTOM (open standard) and IFW (IBM proprietary) act as reference models, benchmarks and accelerators for content and executables.
  • Process standards such as CMMI and ITIL act as benchmarks and accelerators for architecture, engineering and management processes.

You might ask, why do we need so many, and how do they all fit together? To answer that question, let's look in more detail at the standards landscape, and see how semantic standards, format standards, framework standards and industry model standards come together in support of accelerated BPM value.

 

 

Semantic standards: The Open Group SOA Ontology

The Open Group recently announced the availability of the Service Oriented Architecture (SOA) Ontology Technical Standard, which is intended to develop and foster a common understanding between business and IT communities regarding SOA concepts and terminology. The ontology defines the concepts, terms and semantics of SOA in a common language that allows for more precise and straightforward communications across the enterprise, reducing ambiguity and misunderstandings.

Semantic standards such as the SOA Ontology provide common terminology and concept mapping that business and technical people can employ to discuss problems and opportunities. Furthermore, such semantic standards bridge different architecture, engineering, business and marketing domains. While rarely complete from a coverage perspective, nevertheless semantic standards create a consistent foundation for inter- and intra-domain communication, a foundation that becomes the backbone of the lingua franca for the enterprise landscape.

Despite years of evolution in systems, SOA, BPM and EA people are often still divided by differing uses of common terms. Definitions of routinely used words like “process,” “service,” “component,” “system,” and “task,” and how those terms relate to each other, can have varied meanings depending on who or what product or tool is doing the defining. In particular, business and technology people may not assign the same definitions or understanding to a concept.

Making sure that you're speaking the same language is essential for any architect to be able to communicate effectively with IT, business, and marketing professionals within the enterprise, as well as with vendors and suppliers outside the enterprise. Until very recently though, there has been little focus in the industry on semantic standards; most standardization efforts have been addressing resource format standard. That balance needs to change, especially because format standards have little value without common semantics for the kinds of things that the format standards apply to. After all, what good is a standard for process model notation if we don't agree on the concept of process itself?

 

 

Resource format standards: BPMN

Business Process Modeling Notation 2.0 (BPMN) seems to be the next big thing in the world of BPM, but should we really care from a business perspective? BPM is a business-oriented discipline after all, so does it really matter what the IT industry does to make processes executable? And how does BPMN 2.0, with its focus on the standardized exchange of processes, fit with the notion that we should really stop copying and start linking instead across disciplines and domains like BPM and EA? And what has any of that got to do with agile change?

Let's take a closer look at what BPMN 2.0 is and isn’t:


What is BPMN

BPMN 2.0 is …

BPMN 2.0 is not …

  • A formal industry standard.
  • A standardized way of expressing processes (common visual language).
  • Applicable (with value) to a pure business domain.
  • A foundation for standardized exchange of process resources.
  • Executable at the highest level of detail.
  • A substitute for SOA standards.
  • A process editor (but it can support one).
  • A programming model.
  • A platform.
  • A discipline.
  • An architectural approach.

 

What this tells us is that there are two very different value propositions for BPMN 2.0. Only one of these is related to standardized exchange; the other is related to the need for a common standardized language that allows us to talk about and define business processes. The latter is critically important for a tribal enterprise desiring to become a nation, and is not related to “copying” at all.

In short, BPMN 2.0 remains an integral part of the future of BPM, but we should adopt a perspective on how best to apply BPMN 2.0 that is more nuanced than much of what has so far been discussed publicly. This perspective must include how to leverage BPMN 2.0 for consumability within and across BPM and other process-oriented disciplines, as well as how to merge linking and BPMN 2.0 resource representations in an effective fashion.

 

 

Linking format standards: OSLC

Open Services for Lifecycle Collaboration ([OSLC]) is an open community of individuals from customers, IBM partners, systems integrators, competitors, open source communities and academia (see Figure 1). The community focuses on interoperability interfaces between lifecycle tools for software and systems development, using a technology-neutral approach based on internet standards and protocols.


Figure 1. Front page of open-services.net
Front page of open-services.net

What's important for our understanding of the standards landscape is that, contrary to many other format standards, the OSLC specifications do not focus on the format of a resource, but rather on standardized semantics and formats for links between resources. OSLC specifications importantly include both REST interfaces that must be supported for creating, managing and linking resources and user interface components that must be provided for remote lookup, search, and so on. Different OSLC servers will own and control their own OSLC resources, but will provide just enough standardized interaction semantics to provide a integrated network of linked resources. This environment is not a federated repository, nor a set of isolated repository islands, but rather a semantic resource web very similar in nature to the World Wide Web of internet pages.

Without an industry standard for links it would be very hard, if not impossible, to stop copying and start linking across the enterprise landscape. Consequently, the OSLC specifications are a very critical enabler for the transition from "tribes" to "nations."

 

 

Framework standards: TOGAF

The Open Group Architecture Framework (TOGAF) is a documented set of techniques and tools for developing and supporting enterprise architecture. TOGAF describes a meta model, the views and viewpoints associated with the meta model, and the types of phases that a typical enterprise architecture practice will perform. Okay, so what has an EA standard got to do with BPM? TOGAF is relevant to BPM in two different ways:

  • As the preferred architectural framework for many enterprises, hence something that BPM practitioners must be able to relate to.
  • As a representative of the class of framework standards. Currently no BPM-specific framework standards exist, but wouldn’t it be far easier to collaborate within large distributed BPM initiatives if we had clear standardized definitions of BPM phases and artifact types?

Continuing with TOGAF as our example of a framework standard, the phases of TOGAF provide a general approach to enterprise architecture development, as shown in Figure 2.


Figure 2. TOGAF phase model
TOGAF phase model

Each of these phases consumes and produces work products and artifacts that assist in the development of the architecture. Underlying these phases is an abstract artifact meta model that can be interpreted and augmented for a particular enterprise, serving as both a benchmark and an accelerator for architecture development.

In general, framework standards such as TOGAF provide much needed classification and structure for work products--something that is especially important for cross-domain collaboration where crisp context and linking is required.

 

 

Industry model standards: IFW

IBM’s Information Framework for Banking (IFW) is a typical example of an industry asset that is a benchmark, a reference model, and an accelerator all at the same time:

  • As a benchmark IFW provides input to and guidance for BPM blueprints and standards.
  • As a reference model, IFW provides business structure and classification to the resources and assets in a BPM portfolio.
  • As an accelerator, IFW provides seed content for BPM projects and solutions.

Not all industry model standards will address all three of these, but all three are in fact typically needed for an accelerated and sustainable BPM transformation. Consequently an enterprise embarking on such a transformation should consider up front which industry models and industry model standards to apply, and leverage those industry models and standards right from the start of the journey. After all, creating models and content is relatively easy compared to the challenges intrinsic in managing and governing what has been created over time.

 

 

Process standards: CMMI

Capability Maturity Model Integration (CMMI) is a process improvement approach that helps organizations improve their performance. CMMI can be used to guide process improvement across a project, a division, or an entire organization. This is not process improvement in the BPM sense of optimizing business processes, rather it is improvement of the requirements, engineering and management processes that need to be focused on for effective development and collaboration.

While not directly applicable to the enterprise landscape, CMMI does provide a catalog of engineering processes for which we need to establish a common language and appropriate collaboration patterns. Furthermore CMMI allows us to benchmark the maturity of our existing engineering processes, as well as measure progress over time.

In general, process standards have the same characteristics as CMMI, and while not absolutely required, such standards do provide an additional tool in the tool box for enterprises embarking on a long term journey towards better business outcomes and improved business agility.

 

 

Conclusion

In truth, few enterprises need to consider all the different kinds of standards described above--at least not for the first few years of a BPM journey. Having said that, it is still important to understand the value of each type of standard in order to better decide which standards to leverage and when. In particular, understanding the different format standards is critically important for the immature BPM initiative; without such understanding it is very easy to produce assets that are not robust against change or that fail to be understood by anyone outside the initial BPM team.
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  • Stop copying, start linking** (Jensen, developerWorks, 2009)
  • From Tribes to Nations (Jensen, blog entry)
  • Continuous improvement witb BPM and EA together (Jensen, 2010) (PDF)
  • developerWorks BPM zone**: Get the latest technical resources on IBM BPM solutions, including downloads, demos, articles, tutorials, events, webcasts, and more.
  • The Open Group SOA Ontology
  • BPMN.org
  • TOGAF V9 Enterprize Edition
  • IBM Banking Content Pack V7, Information FrameWork (IFW) **
  • Capability Maturity Model Integration (CMMI)
  • Open Services for Lifecycle Collaboration
  • Service oriented architecture Modeling Language (SoaML) documentation
  • Service Component Architecture (SCA) Home
  • Reusable Asset Specification (RAS)
  • Business Process Framework (eTOM) In Depth
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In November 2010, IBM unveiled a new BPM cloud offering called IBM Blueworks Live, shown in Figure 1. Current users of IBM BPM Blueprint and IBM BPM BlueWorks now have a single place to go to experience BPM in the cloud. Blueworks Live combines the best of the previous offerings--the community aspect of BPM BlueWorks with the streaming features of Blueprint, and much more.


Figure 1. Blueworks Live inherits the familiar user experience and interface of BPM Blueprint
Blueworks Live

In this column, I want to introduce you to a few things everyone should know about Blueworks Live.

Community integration

By combining and enhancing the best features from IBM’s BPM Blueprint and BPM BlueWorks, Blueworks Live provides a greatly improved BPM SaaS offering. The social BPM aspect that I discussed in Get social with IBM and BPM is one of these features. Blueworks Live’s idea of public community includes BPM-related tweets accessible through public BPM streams (see Figure 2) and blogs by regular bloggers (see Figure 3). Business process templates created using Blueprint’s popular process editor are also available publicly. The public community is accessible by all users, registered and non-registered alike.


Figure 2. The public BPM stream is the center of the public community
The public BPM                                         stream is the center of the public community

 

 

It's readily apparent that the one feature that was given a lot of design consideration is the private community. A private community is created for every account in which innovative collaboration among users in the account takes place.


Figure 3. You can still find your favorite bloggers from BPM BlueWorks in IBM Blueworks Live
Favorite bloggers

 

 

This notion existed in both BPM BlueWorks and Blueprint. But this time, the private streaming of activities that was available in Blueprint is enhanced, as shown in Figure 4. Notice that both private and public streams are visible to the user. Note also that only entries the logged-in user has the permission to see appear in the streams.


Figure 4. The private activity stream keeps everyone up to speed with the activities in the account
private activity stream

 

 

Another new social feature worth mentioning is the ability to create posts in the private community. Other users can reply to these posts, enhancing the social interaction.

IBM BlueWorks also introduces the notion of creating "smaller communities" within the private community. These smaller communities are called spaces. Spaces are a way of managing the larger community in more logical sub-organizations. A possible scenario is creating a space for each department in a company account, such as Accounting, Purchasing, Engineering, and so on, as shown in Figure 5. Users have to be members of a space in order to access it. Users can be members of multiple spaces. Within a space, a user can author and review process documents, depending on the permissions given to him or her in that space. Users can have different permissions in different spaces. All assets that are created, such as process documents, must live in a space and can be shared among the space members.


Figure 5. Example of spaces within an account
Example of spaces within an account

A space also has its own stream for all activities happening within the space. Members can post to the stream and reply to posts, as shown in Figure 6. Entries in a space stream also appear in the private community stream, but only if the logged-in user has permission to see those entries.


Figure 6. Activities within a space can be monitored through the space's stream
Monitoring activities in a space via a stream

 

 

The concept of community is so central to Blueworks Live that a new type of license is available called the community license. A user with this license can participate in Blueworks Live through its community features alone.

 

 

Doing business in the cloud

One of the greatest values provided by Blueworks Live is something that wasn't available in previous offerings: the ability to define simple business processes and execute them in the cloud. This feature is what sets Blueworks Live apart and offers a quick on-ramp to running business processes in the cloud.

There are two types of simple business process patterns that are supported in the initial release: simple workflow and checklist. A simple workflow is a sequence of tasks that need to be completed in a specified order. If any of the tasks cannot be completed, an option to cancel the work is provided. A task in a simple workflow may require human approval. A checklist, on the other hand, is just a set of tasks that needs to be completed regardless of the order. In other words, there are no dependencies among these tasks. As with a simple workflow, if any of the checklist tasks cannot be completed, an option to cancel the whole work is provided.

Blueworks Live calls this feature of defining and executing simple business processes process automation. While the process automation that is provided by Blueworks Live is still rudimentary, it's a big step in providing the foundation for the next iteration of more sophisticated process patterns.

As a simple illustration, you can easily automate a process with a click of a button and choose between the two process patterns or types, as shown in Figure 7, where the process Submit Purchase Requisition is a simple workflow.


Figure 7. Automating a process is as simple as clicking a button and filling out a form
Automating a process

The process automation definition that is created is called a Process App. The process app must also belong to a space. Every process app needs to be configured, which includes listing the tasks that comprise the workflow. In this example, we defined the workflow to have five discrete tasks, as shown in Figure 8. In a simple workflow, a task may require an approval. For example, the third task requires that somebody from the Accounting department approve the purchase requisition. Once configured, the process app is shared with participants in the account so that it can be used. A participant is a registered user in the account, who has the ability to launch process apps (that is, initiate and start) and execute tasks. This means that a participant with access to this process app can launch a specific work item that follows the workflow defined in the process app.


Figure 8. Configuring a process app requires listing the tasks that comprise the workflow
Listing workflow tasks

Before a user can launch a process app, he or she needs to assign the tasks to certain individuals in the account and specify their due dates, as shown in Figure 9. As soon the user clicks Launch, the first task assignee is notified of the task that he or she needs to accomplish. Since we have a sequential workflow, other assignees will only be notified after the task that immediately precedes their task is completed. If this was a checklist process, all task assignees would be notified at the same time since the checklist doesn't require an order or sequence in which the tasks must be completed. In Figure 9, Kevin is the first to be notified of a task that is assigned to him.


Figure 9. Launching a process app involves assigning owners and due dates for each task in the workflow
Launching a process app

When Kevin logs in to his account, he sees the list of outstanding tasks that are assigned to him in the Work tab. He also gets reminders for all tasks that are overdue. He can see the details of his task by simply clicking it. Figure 10 shows an example of what he sees. Comments and replies can be posted on this specific work item to facilitate communication among the people involved.

Blueworks Live also provides the flexibility to add new tasks when necessary. For example, Kevin may decide to create a task for Wil to review the specifications and submit a summary of the required flooring. When Kevin has completed this task, he can click Complete and the task goes to his list of completed tasks. Meanwhile, a task is created for Olivier, who owns the next task, and a notification is sent to him. This procedure continues until the last task is completed, at which time the work item is fulfilled and completed. Note that in situations when a task owner is unable to perform the task, it can easily be reassigned to another user.


Figure 10. Task Assignees have visibility of the whole workflow and can perform actions on their tasks
Task Assignees have visibility of the whole workflow and can                                         perform actions on their tasks

This is a simple example of a business process that is easily executed and coordinated within Blueworks Live. A view of the different tasks, their assignees and the current status of the entire work item is available in the cloud. This is what we mean by BPM in the cloud!

 

 

Conclusion

Blueworks Live is the integration of the best features of BPM BlueWorks and BPM Blueprint, and more. The enhanced community features and the ability to automate simple processes in the cloud are just a taste of things to come!
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  • Check out Blueworks Live and start documenting and running processes in the cloud
  • Get social with IBM and BPM** (Jamison, IBM BPM Journal, 2009)
  • developerWorks BPM zone**: Get the latest technical resources on IBM BPM solutions, including downloads, demos, articles, tutorials, events, webcasts, and more.
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Introduction

IBM WebSphere Lombardi Edition (Lombardi) V7.1 was the first IBM offering of the product previously known as Lombardi Teamworks. The primary focus of the V7.1 release was to integrate the Lombardi product suite into the WebSphere family and make it more consistent with IBM support standards. Other than the new name, the key changes include moving the embedded application server from JBoss to WebSphere Application Server Network Deployment V7, and enabling support for additional platforms such as AIX®, Linux® on IBM System Z®, Windows® 7, and for DB2® as the database engine.

In December 2010, IBM released Lombardi V7.2. This release continues on the path to integration with extended support such as globalization, so that a user can now choose from fourteen different languages to work with for installation, documentation, product tools and user interface. Lombardi V7.2 also includes an array of feature enhancements. I've had the opportunity to explore this new release and I'd like to share with you the highlights of the three new features I find most exciting, namely:

  • Conditional activity modeling and management.
  • The ILOG JRules Decision Service Integration component.
  • Integration with Enterprise Content Management (ECM) repositories.

For a full list and details of all the enhancements in Lombardi V7.2, refer to the Resources section.

 

 

Conditional activity modeling and management

The Lombardi Authoring Environment now enables users to include conditional activities in their business processes. Conditional activities allow for runtime selection of tasks to perform based on the values of certain process variables, which are set either in the user interface by the end user or programmatically via scripts.

To model a conditional activity, you need to set the Is Conditional attribute for an activity in the Authoring Environment to mark it conditional. When an activity is conditional, it displays a small diamond, as shown in Figure 1.


Figure 1. Conditional activity attribute and decoration
Conditional                                         activity attribute and decoration

Lombardi provides a built-in wle Select Conditional Activity Coach, as shown in Figure 2, that the user can use to select which conditional activities to execute. The selection setting is stored and later accessed from the tw.system.step.isConditionalActivitySelected JavaScript property in the condition script for the activity to indicate whether it should be performed or skipped.


Figure 2. Conditional activity selection Coach
Conditional                                         activity selection coach

The default behavior can be overridden with a customized script to dynamically determine whether a conditional activity is executed based on variable values, set by a rule service, for instance. For example, in the sample process application for Conditional Activities that comes with Lombardi V7.2, the Rule service wle Determine Needed Steps reads in the new employee type and sets the value for variables accordingly, such as tw.local.itSteps.eclipse, as seen in Figure 3.


Figure 3. wle Determine Needed Steps Rule service
wle Determine                                         Needed Steps Rule service

This in turn is specified as the JavaScript expression in the condition script that determines whether the activity Install Eclipse IDE is performed, as shown in Figure 4.


Figure 4. wle Setup computer condition script
wle Setup                                         computer condition script

 

 

ILOG JRules Decision Service Integration component

Prior to V7.2, accessing an ILOG execution server to take advantage of the external rule services was possible, but required manual set-up of a web service client connector. Lombardi V7.2 provides a new ILOG JRules Decision Service Integration component that simplifies the integration configuration of ILOG JRules servers, enables discovery of available decision services running on the servers, and generates the artifacts for the underlying web services calls.

A new type of process application environment variable dedicated to ILOG Rule Servers is introduced. One or more ILOG Rule Execution Server specified with such environment variables, as shown in Figure 5, are made available to all process and service authors to use, as shown in Figure 6.


Figure 5. Environment variables for ILOG execution servers
Environment                                         variables for ILOG execution servers

Figure 6.
Available JRules servers, RuleApps and rulesets discovery
Available                                         JRules servers, RuleApps and rulesets discovery

Additionally, discovery service is available for JRules servers with a SOAP port. A query is executed upon connecting to the server to discover the RuleApps running on it, along with the associated rulesets and their versions. The data returned is populated into the drop-down lists. For servers without a SOAP port, the information for the RuleApp and ruleset can be entered manually, as shown in Figure 6. Custom types for the inputs and outputs can be generated with RuleApp ad ruleset information, either discovered or entered. Data mapping can be done automatically based on the generated types, to map inputs and outputs to the JRules service, as shown in Figure 7.


Figure 7. Data mapping for rule inputs and outputs to JRules server
Data mapping                                         for rule inputs and outputs to JRules server

 

 

Integration with Enterprise Content Management (ECM) document repositories

In addition to the existing internal document repository, Lombardi V7.2 supports a variety of ECM repositories by way of integration enabled by the IBM Content Integrator (ICI). Both IBM FileNet Content Manager and IBM Content Manager come with ICI, so they work with Lombardi V7.2 out of the box. The Document Attachment Coach control has been updated to retrieve documents stored in an ECM repository. A new Document Viewer widget allows for documents from an ECM repository to be viewed from within a Coach.

The ECM repositories are set up once as process application environment variables with types of either "ICI Web Service URL” or “ICI Connector Name,” as shown in Figure 8. Once configured, the repositories become available in the dropdown list on the Connection Properties page in the Document Attachment Coach control for the process authors to choose from.


Figure 8. Environment variables for ICI repositories
Environment                                         variables for ICI repositories

Also in the Coach control, authors can define search filters to limit the list of documents returned to the users and choose to enable or disable uploading of documents to the ECM repository, as shown in Figures 9 and 10.


Figure 9. Coach control: document list/attach for ECM documents
Coach control for                                         ECM documents

 

 


Figure 10. Runtime: ECM document list
Runtime: ECM                                         document list

 

 

A Document Viewer can be configured to be associated with a Document Attach List, as shown in Figure 11. At runtime, it displays a page similar to Figure 12, where a Document Viewer is shown next to the list of documents and renders a selected document, as long as the type of document is supported by the browser.


Figure 11. Coach control: Document Viewer for ECM document
 Coach                                         control: Document Viewer for ECM document

 

 


Figure 12. Runtime: ECM document shown in Document Viewer
Runtime: ECM                                         document shown in Document Viewer
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Introduction

Location awareness is an important element of business event processing when the location of the events being processed forms a part of the patterns that are to be detected. Location-aware event processing is relevant across various industries--transportation, provision of services, and location-based marketing to name but a few. Following are some examples in such industries.

Example 1: Service interruptions

The first scenario, shown in Figure 1, considers a service where location is relevant to the provisioning of that service and where reports of interruptions to the delivery are likely to be clustered around allocation area or zone. The scenario considers problems being reported by customers to a service and how the customer care experience can be improved to best handle the case when the reports for an area hit a threshold. The scenario assumes that all reports are handled, but the issues that are impacting most customers for a given area are fast tracked. The problems for a mobile operator might be dropped conversations, poor signal quality or intermittent coverage. All of these will reduce customer satisfaction, ultimately leading to the loss customers.

The report being raised by a customer includes information about the location related to the incident. This would most likely be an address (a postal code). The location-aware piece of the solution translates this address into a location and looks for a pattern where three tickets are raised for the same service over a 30-minute period. If this condition is met, an action is sent to a supervisor with a higher importance than the individual reports so that any follow-on work to resolve the problem can be coordinated. Once the problem has been identified and an expectation for the resolution is known, a reply is sent to the originators. At this stage, we have the opportunity to leverage location awareness again to notify all people who are likely to be disrupted by the problem, not just the original reporters. Finally with the problem resolved, a follow-up message is sent to thank those who reported the original problem.


Figure 1. Service interruptions scenario
Event processing scenario for service interruptions using location information

The location awareness piece of this solution is where the issue’s location is identified as belonging to a specific area of coverage. The event processing is able to correlate these requests looking for patterns in both proximity and time.

Example 2: Multiple late deliveries

Another scenario where location awareness is important is seen in Figure 2. Consider a delivery company that wants to provide their customers with information about the likelihood of a delay and also to give them the opportunity of a discount if a delay is certain.

If we have a record of a vehicle’s position over time and know when it’s expected at a particular destination on a delivery route, we can use its current position to determine whether it’s likely to be late. If the vehicle is late multiple times on the same route, we can automatically recommend that the customer receive a discount, or take some other action knowing that it is likely to be late. This could also be useful for rerouting deliveries in the future to improve levels of service and customer expectations.


Figure 2. Multiple late deliveries scenario
Event processing scenario for multiple late deliveries using location information

Example 3: Location-based marketing

This scenario, shown in Figure 3, is an example of a service that's based of the knowledge of a person’s mobile phone location. This scenario requires customers to opt in to the service, because they will be required to surrender some of their privacy to the operator. However we're already seeing people beginning to release location information to trusted parties, such as Google Latitude, Facebook and Twitter.

This scenario assumes a person has shared their location with a third-party location-based marketing service that also has access to some of their previous purchases at retail locations that are also signed up for the offering. The scenario is triggered by a person moving near a retail location--in this example, a coffee shop. The system identifies that the person has made previous purchase at this location and, therefore, has in the past been interested in what they have to sell, such as coffee. If records show that they haven’t made any purchases in the past month then they are issued an offer to encourage them to return to the store.


Figure 3. Location-based marketing scenario
Event processing scenario for location based marketing

In this example, the location awareness piece of the solution is used to establish whether the event from the mobile is either within a predetermined area or within a certain distance of the store. Event processing stores and acts on both the proximity and the previous purchase history.

 

 

Deriving meaning from a location-based event

The fundamentals for deriving meaning from a location-based event are:

  • Considering events within an area
  • Distance from an event to a known point
  • Proximity to another event in both distance and time

Implementing the location-aware scenario demonstrates how you can use WebSphere Business Events to work with events containing location information to create actions that can alert and visualise this awareness for each of the three meaningful concepts.

For events within an area, we detect the areas containing the event, where the event sent to WebSphere Business Events (Business Events) contains location information and Business Events checks whether the location is inside the areas defined in our seeded database data. We're also able to detect whether an event is entering or exiting an area by comparing previous events containing areas with those of the new incoming event. This needs to be done in the context of an identifier for that event so we can keep track of different location events.

Three main components are used in the solution:

  • Business event processing is provided by WebSphere® Business Events V7.0.1.1,
  • Spatial database and calculations is provided by DB2® Spatial Extender.
  • Visualisation is provided by WebSphere ILog® JViews Maps.

Note that other providers such as ESRI® could be used for visualisation. Essentially all that is required is that the mapping and visualisation solution is able to be configured to understand the spatial data in our database.

 

 

 

The scenario

We've developed a simple scenario using database tables with some seeded data to represent:

  • Transports (for example, ships, planes, trucks)
  • Places (the point location of a place, such as the centre of an airport)
  • Areas (the geofence surrounding a place point, for example, airport airspace or harbour jurisdiction)

Business Events can be used to detect patterns related to the location of a transport by referring to the database tables when an event for updating a transport location arrives. A compelling business scenario can be developed from these concept tables, such as asset or package tracking. A list of packages could be loaded into another database table and then related to the transport by the transport ID. When the package moves to a different transport, the transport ID for the package can be updated to reflect this.

Knowing where the package is located by sending transport location updates to Business Events enables us to detect location-related patterns. For example:

  • Knowing when a transport has entered an area, the courier company can pass the information to the customer that the package is about to arrive at its destination. Similarly, if the transport leaves an area, the package can be considered on its way to a new destination. The knowledge that a package remains in an area is also useful. This information can be derived from the previous events.
  • If an incident occurs at a place and that place is the destination of the transport or the transport is within a certain distance of the place, an exception event can be raised to re-route the transport. This knowledge can be used to inform customers of late delivery and provide an opportunity to move the package to a different transport in order to continue the delivery.
  • If a position update to a transport gives the same location as before, the transport could be considered stopped for some reason and an exception event processed such that an intercept to that transport is required to continue the package delivery.
  • Knowing the position of a transport on a particular route can be used to compare with previous runs of that route and so give an accurate indication of the estimated arrival time.

Figure 4 is a simple diagram of the database layout for the scenario.


Figure 4. Scenario database layout
Scenario database layout

 

 

 

Implementing the location-aware scenario

The following describes how to implement the scenario using Business Events, and briefly demonstrates a simple implementation of tables and views so that detected events can be visualised.

This section assumes the reader has some knowledge of Business Events and builds on this knowledge by introducing the database spatial extensions. Each of the pattern types covered in the previous section are described in detail here.

The scenario implemented by the project and example database is simplistic, but could form the basis of a real-world project by adding features such as different transport types and incident types. Each incident type could be designed to trigger specific interaction sets to derive alerts to the visualisation and other actions.

 

 

Geofencing

Geofencing can be described as:

  • The ability to determine whether an event is within an area (frequently referred to as a geofence). For example, a truck being inside the area of a depot.
  • The ability to determine whether a point has entered or exited an area. For example, the truck has now arrived or left the depot.


Figure 5. Example geofence
Example geofence

For the purposes of visualising on a map and thus being able to make decisions based on the location of an object, it's often important to know whether an object is inside a particular area or geofence.

For example, you may be looking at a map of vessels near a port. Perhaps the port has an area of demarcation around it such that the port authorities are responsible for all vessels within that area. In that case, it would be important for the authorities to be aware at a glance of which vessels are within the area. This is also true for other types of transport, such as knowing whether an aeroplane is within the airspace of an airport or trucks inside the parking lot of a depot.

Using Business Events, it's possible to build a project so that an incoming event, such as the movement of a position of a vehicle, fires queries to a database to find matching geofences that the vehicle is currently within. The project can then be made to fire subsequent events (for further processing) or actions per matching geofence--it's perfectly reasonable that place areas could overlap and so a vehicle may be considered inside more than one geofence at a time.

The actions or subsequent events (synthetic events) could then perform updates to the database so anything visualising the vehicle could be made to show that the vehicle is within that particular place area.

All this relies on a database with seeded data as the basis for the data being queried, updated and used by the visualisation application. In this article, we'll show example tables containing spatial data types and how Business Events can be made to query and update those types for our example scenario.

To determine matching place areas for a vehicle (or transport as we'll call it here) we use a table containing a row for each place, where one of the columns is a geofence that describes the area of that place.

Geofencing database queries

These DB2 SQL code snippets show how the scenario database tables are built and example queries.


Listing 1. SQL for the creation of the AREAS table

CREATE TABLE AREAS
(id SMALLINT NOT NULL,
name VARCHAR(60),

geofence ST_POLYGON);



Listing 2. SQL to seed the AREAS table

INSERT INTO AREAS
    (id, name, geofence)
  VALUES
    (1, 'Southampton Docks',
     ST_Polygon('polygon((50.916 -1.459, ...))',1003)),

    ...);



Listing 3. Example SQL and results to determine which areas a location is within

SELECT id, name FROM AREAS
WHERE (DB2GSE.ST_CONTAINS(geofence,
  DB2GSE.ST_POINT(50.78,-1.3,1003)) = 1);
 
Area(s) containing the point 50.90,-1.42
 
ID     NAME
------ --------------------------------------------------------
     1 Southampton Docks

     2 Solent Waters

                                               

Note: The downloads provided with this article include files for the SQL to create the tables along with the accompanying example select statements.

 

 

Geofencing work in Design Data

A touchpoint named Transport contains an event named Position Update for Inside an Area. This event is used to send updates to the position of a given transport. The event contains an event object named Location Update, which in turn includes the fields Transport ID, Latitude and Longitude, as shown in Figure 6.


Figure 6. Location Update event fields
Location Update event fields

Note: To simplify the testing of the application, different event names have been used for each of the use cases. In this case, Position Update for Inside an Area is being used. In reality there would only be one event that updates a transports location and all event processing for that type of event would use that location update event.

This is used to construct two intermediate objects, Location Data and Areas. All of the fields are mapped to the Location Data; only Transport ID is mapped to the Areas intermediate object.

A SQL mapped expression is used to construct two fields (Area ID and Area Name) of the Areas intermediate object. As shown in Listing 4, the WHERE clause is used in this mapped expression, which also associates with the AREAS table within the SPATIAL database:


Listing 4. Geofencing Design Data mapped expression

WHERE (db2gse.st_contains(
  AREAS.GEOFENCE, db2gse.st_point(

    $(Location Data.Latitude),$(Location Data.Longitude),1003)) = 1)

 

Figure 7 shows the settings for the Area ID intermediate object field.


Figure 7. Area ID intermediate object
Area ID intermediate object

Figure 8 illustrates all of the mappings and field constructions that have been established in Design Data for identifying which areas a location is within.


Figure 8. Geofencing mappings and field constructors
Geofencing mappings and field constructors

The mapped expression is used to derive the Area ID and Area Names that match the SQL WHERE clause, using the AREAS table. The WHERE clause also uses the Latitude and Longitude fields of the incoming Position Update event, stored in the Location Data intermediate object.

The Transport in Area action created from the synthetic event of the same name needs to be set to generate multiple actions for each action object such that an action is created per matching geofence found using the SQL WHERE clause, as shown in Figure 9.


Figure 9. Transport in Area action properties
Transport in Area action properties

The Containing Area action object needs to be defined such that it will cause each action object to produce a new action, as shown in Figure 10.


Figure 10. Containing Area action object properties
Containing Area action object properties

 

 

Geofencing work in the Design widget

In Business Events Design an interaction set fires the synthetic event for the areas that contain the transport's location. A regular action is also fired so that the action and values can be observed within the Business Events Tester widget, as shown in Figure 11.


Figure 11. Inside an Area interaction
Inside an Area interaction

The synthetic events can now be used for further processing by interaction sets related either to the area, the transport or a combination of the two.

 

 

Testing the geofencing

You can trigger the interaction using the tester widget, by selecting the appropriate event template, as shown in Figure 12.


Figure 12. Selecting the template for inside an area
Selecting template for inside an area

Enter the event data, for example, this position matches two of the geofences in our example data, as shown in Figure 13.


Figure 13. Example event data for Location Update
Example event data for Location Update

When the event is sent, two actions are generated, each containing objects with fields specifying the matching geofence, as shown in Figure 14.


Figure 14. Actions from matching areas
Actions from matching areas

If user trace is enabled, you can see the query made to populate the intermediate objects used to create the actions, as shown in Listing 5.


Listing 5. User trace showing geofencing query

BEER9027 > Executing SQL 'select AREAS.ID, AREAS.NAME from AREAS WHERE ...
BEER9029   SQL Results : {1 ; Southampton Docks}{2 ; Solent Waters}

BEER9028 < Retrieved 2 rows.

 

 

 

Entering or exiting a geofence

As an extension to knowing whether something is within a particular geofence, it can be useful to visualise or alert when a transport has entered or exited a geofence. For example, an aeroplane entering a particular airspace may need to notify the airport authorities, or the authorities may need to be notified automatically and make contact with the craft. Being notified of this event is especially useful when represented visually.

Similarly if a transport leaves the area of a geofence, the authorities of that area may want to know that they're no longer responsible for that transport.

 

 

Entering or exiting database queries

Below is a sample of DB2 SQL and results, listing all areas that a point moving from 50.78,-1.3 (previous location) to 50.90,-1.42 (current location) is entering.


Listing 6. Areas that a point have entered

SELECT id, name FROM AREAS
WHERE(db2gse.st_contains(GEOFENCE,
      db2gse.st_point(50.78,-1.3, 1003)) = 0)
AND  (db2gse.st_contains(GEOFENCE,
      db2gse.st_point(50.90,-1.42, 1003)) = 1);
 
Area(s) that a point moving from 50.78,-1.3 to 50.90,-1.42 is entering
 
ID     NAME
------ ------------------------------------------------------------

     1 Southampton Docks

                                                       

Note: A spatial index on the GEOFENCE field not exploited for queries using st_contains()=0. This may become create a problem with query speed when there are a large number of areas.

Entering or exiting geofence work in Design Data

The event named Position Update for Entry and Exit drives this use case. As before this event contains the Transport ID, Latitude and Longitude. Figure 15 shows the mappings and field constructors used to derive the Entering and Exiting logic.


Figure 15. Entering and exiting mappings and field construction
Entering and Exiting mappings and field construction

Transport ID, Latitude and Longitude are mapped to the Location Data intermediate object. In addition, a Location Data with Previous intermediate object is used. This is a specialised summary instance intermediate object as defined in the Object tab of the properties, as shown in Figure 16.


Figure 16. Location Data with Previous object properties
Location Data with Previous object properties

A summary instance intermediate object can be used to hold the state within fields from previous events. Two fields are mapped from the latitude and longitude that has been received on the incoming event. Two additional fields take a copy of the previous values of these fields before this mapping takes. The following shows the field construction of one of these fields.


Figure 17. Field construction for Location Data with Previous
Field construction for Location Data with Previous

Note: This field construction is associated with the incoming event and takes place in the Touchpoint portion of Design Data.

Two further intermediate objects are defined: Areas Entered and Areas Exited. These are both similar to the Areas intermediate object already described with the exception of the WHERE clause that they use in the mapped expressions. Listing 7 shows the WHERE clause for the Areas Entered case.


Listing 7. Areas Entered mapped expression WHERE clause

WHERE (db2gse.st_contains(
  AREAS.GEOFENCE, db2gse.st_point(
    $(Location Data with Previous.Previous Latitude),
    $(Location Data with Previous.Previous Longitude), 1003)) = 0)
  AND (db2gse.st_contains(
AREAS.GEOFENCE, db2gse.st_point(
    $(Location Data with Previous.Current Latitude),

    $(Location Data with Previous.Current Longitude), 1003)) = 1)

 

Notice how the Location Data with Previous intermediate object is used. The two halves of the WHERE clause first select the areas that did not contain the previous location, the select those that now contain the current location. Where both of these are true, the transports location has moved into the returned areas.

A similar WHERE clause is used for the Areas Exited case, as shown in Listing 8, with the only difference being that it returns areas which used to contain the moving location, but no longer do.


Listing 8. Areas Exited mapped expression WHERE clause

WHERE (db2gse.st_contains(
  AREAS.GEOFENCE, db2gse.st_point(
    $(Location Data with Previous.Previous Latitude),
    $(Location Data with Previous.Previous Longitude), 1003)) = 1)
  AND (db2gse.st_contains(
AREAS.GEOFENCE, db2gse.st_point(
    $(Location Data with Previous.Latitude),

    $(Location Data with Previous.Longitude), 1003)) = 0)

 

 

 

Entering or exiting geofence work in the Design widget

A filter is required for each of the entering or exiting cases. These filters simply check to see whether intermediate objects exist for each cases. Figure 18 shows the filter created for the entry into an area.


Figure 18. Filter to determine area entry
Filter to determine area entry

These filters can then be used generate the appropriate alerts, as shown in Figure 19.


Figure 19. Interaction to alert for entry or exit
Interaction to alert for entry or exit

In this case, only alerts are being generated for the two cases of entry or exit from an area. Actions generated by entering or exiting could just have easily been used for further processing as synthetic events. These events could then be related by either the transport id or the area id.

 

 

Testing entering or exiting geofence

To test this part of the example scenario, we must first send a position update event to seed the summary instance object with a position for a transport that we'll use to test for entry or exit.

From the scenario project, select the Position Update for Entry and Exit event template in the tester widget, and enter values to seed an existing transport id with a position, as shown in Figure 20.


Figure 20. Seeding a transport for testing entry and exit
Seeding a transport for testing entry and exit

At this point, we shouldn't receive any actions as a result of this event since our Previous Latitude and Previous Longitude intermediate object fields are null. Now if we send a similar event, but with a location that is outside of the geofence that currently contains our transport, we'll see a matching action, as shown in Figure 21.


Figure 21. Update a transport position for testing entry and exit
Update a transport position for testing entry and exit

Sending this event reveals the exited area in the subsequent action, as shown in Figure 22.


Figure 22. Exited area action
Exited area action

If we now send the originally seeded data again as in Fig. 20, we'll see the Areas Entered action, as shown in Figure 23.


Figure 23. Areas Entered action
Areas entered action

Voila!

 

 

Proximity to a known point

For purposes of the scenario, the proximity to a known point is the ability to calculate distance to a fixed known point for subsequent use in logic, for example, "Distance to light house in meters < 1,000."


Figure 24. Proximity to a known point
Proximity to a known point

As well as determining if a transport is within a particular distance to a point, it can also be useful to know the distance to a the nearest edge of a particular geofence and to fire an action to visualise or to alert when that happens. For example, the crew of an aeroplane may want to know that they need to be prepared to make communication with the airport runway tower.

Again, this depends on the fact that we keep the places and the areas they define in our database and can query for distance of geo-spatial values. Both DB2 (with spatial extender) and Oracle® provide these as common types of queries for spatial data.

It's possible to check the distance measure from within a filter in Business Events by querying the distance for the incoming transport position to its destination (as determined by our database data) and then creating a filter for that. This gives control of the distance threshold to the business user using the Business Events Design application. It's also possible to simply define a view in the database that returns the identities of those places or transports that your incoming transport movement event is close to, in which case the distance threshold would be fixed in the view definition.

 

 

Proximity database queries

The ST_DISTANCE function is used to calculate the distance between two points. In this section the intention, we'll use an example where we'll filter based on the distance between an event location and a fixed place. So first we need to create a places table, as shown in Listing 9.


Listing 9. Places table creation

CREATE TABLE places
  (id SMALLINT NOT NULL,
   name VARCHAR(60),

   point ST_POINT);

 

Next, we'll insert a place into this table to indicate the place that we want to know event distances from, as shown in Listing 10.


Listing 10. Places insertion

INSERT INTO PLACES
    (id, name, point)
  VALUES

    (1, 'Southampton Docks', DB2GSE.ST_POINT(50.90, -1.42, 1003) );

                                                                                                                              

The following statement returns the distance to the place with the id = 1, in units of meters and to one decimal points worth of accuracy.


Listing 11. Distance query and result

SELECT
CAST( DB2GSE.ST_DISTANCE(
  DB2GSE.ST_POINT(50.78,-1.3,1003), places.point, 'METER')
    AS INTEGER) AS distance
  FROM places
  WHERE id = 1;
 
DISTANCE
-----------

      18825

 

This is useful if you're looking for a distance to a given point and is a good example of how to use the distance function.

 

 

Proximity work in Design Data

The interaction used in this scenario is triggered by the Position Update for Proximity to Destination event, which contains the normal position update fields and, crucially, a Destination ID, which is the ID of the places table entry, which is the intended destination of the transport position update.

The SQL expression uses the new position information and the destination to form a query to give the distance of that position from the point of the relevant place, as seen in Figure 25.


Figure 25. Proximity mappings and field constructors
Proximity mappings and field constructors

The Distance intermediate object field is defined in Design Data as shown in Figure 26.


Figure 26. Distance intermediate object field
Distance intermediate object field

 

 

Proximity work in the Design widget

Different filters can now be used in Design, for particular places of interest and, with further control, over the distances that are of interest. The places table could also include type information that could be used in subsequent filters.

You can define a filter to detect events within a vicinity, as shown in Figure 27.


Figure 27. Vicinity filter example
Vicinity filter example

 

 

Testing proximity

We can use the row identifier of the places table to look up the proximity of an incoming event to the location (the Destination ID in the event). To test this, choose the appropriate event template and send a position for a transport and the ID of the destination, as shown in Figure 28.


Figure 28. Choosing the proximity template from the scenario project
Choosing the proximity template from the scenario project

Since this interaction uses the filter Less than 2000 metres to destination, you need to enter a latitude and longitude that places the transport within this distance of its destination, as shown in Figure 29.


Figure 29. Proximity event example
Proximity event example

Firing this event shows you a couple of things in the tester widget: the vicinity filter evaluates to true and you have a Nearing Destination action with details, as you can see in Figure 30.


Figure 30. Action from proximity detection
Action from proximity detection

 

 

Proximity to another event

In order to calculate a proximity to another event, you need to be able to store location information from events.

As an extension of the idea of simply retrieving the distance of a transport from its defined destination, you may want to know what other transports or places are near the incoming transport event, or alert transports in the proximity of a place if there is an incident at that place.

You can use a view definition to allow Business Events to query for transports near a place or other transports and thus fire subsequent synthetic events or actions that could then update your visualisation of those transports with a change of status. This is useful for exception processing. For example, if there is an incident at a place, all transports whose destinations are that place and are within a certain distance would want to be alerted so that decisions can be made whether to reroute the transports to another destination.

You can also configure a project to record the history of the transport positions over time by inserting the information from the transport movement event into a history table. The history of the movement of a transport could be used to visualise the route it has taken over time and thus determine how long it would take to do a similar journey in the future and determine how long the transport might take to reach that destination again. A customer of a package on that transport could then be given an accurate idea of exactly when it would be expected to arrive.


Figure 31. Proximity to another event
Proximity to another event

 

 

Event location database insertion

The transports table, shown in Listing 12, holds the position of each transport. When an incident occurs, the transports within a given distance can be identified. The table holds the id, name and location of a transport as a point type--in this scenario, latitude and longitude.


Listing 12. Transports table creation

CREATE TABLE transports
(id SMALLINT NOT NULL,
 name VARCHAR(60),

 location ST_POINT);

 

If a transport position event arrives using an identifier that does not have a record in the transports table, Business Events can be configured so that an INSERT statement is generated to add it to the table, as shown in Listing 13.


Listing 13. Transports table insertion

INSERT INTO transports
    (id, name, location)
  VALUES
    (1,
     'Southampton Harbour Patrol',

     DB2GSE.ST_POINT(50.90,-1.42,1003));

 

If the transport is already in the table, the current position is used to update the database record, as shown in Listing 14.


Listing 14. Transports table update

UPDATE transports
  SET
    location = DB2GSE.ST_POINT(50.90,-1.42,1003)
  WHERE

    id =1;

 

 

 

Event proximity work in Design Data

Using the JDBC action connector in update or insert mode is also known as upsert. This action connector uses the _Rdbms connector action object, which is inserted from a template.

You then need to define the action object properties as using an RDBMS connection in order to insert or update the database. Configuring the RDBMS connection requires you choose to perform an insert if the WHERE clause finds no rows to update, as shown in Figure 32.


Figure 32. Choosing upsert behaviour
Choosing upsert behaviour

The _RDBMS connector action object contains the following fields:

  • InsertColumns is used to generate the column identifiers from the SQL insert statement; for example, INSERT INTO transports (id, name, location)
  • InsertValues is used to generate the VALUES part of the SQL insert statement; for example, INSERT INTO transports (id,name,location) VALUES (1, 'Southampton Harbour Patrol', 'ship', DB2GSE.ST_POINT(50.60,-1.58,1003) )
  • Update is used to generate the UPDATE SQL clause; for example, UPDATE transports SET name = 'Southern Skylark', location = DB2GSE.ST_POINT(50.31,-1.15,1003))
  • Where is used to generate the WHERE clause used for the UPDATE statement; for example, WHERE id = 1

Table 1 summarizes how the different fields of the _RDBMS connector action object can be used to perform an upsert for our scenario:


Table 1. RDBMS connector field uses

Field

Type

Value

Description

InsertColumns

ConstantValue

id, name, location

The columns that will be used in the case of an insert.

InsertValues

JavaScript

"("+Location Data.TransportID+", '"+Location Data.Transport Name+"', db2gse.st_point(" + Location Data.Latitude+ "," + Location Data.Longitude + ",1003))"

A piece of JavaScript to construct the SQL values clause that matches up with the columns.

Update

JavaScript

"name = '"+Location Data.Transport Name+"', location = db2gse.st_point(" + Location Data.Latitude+ "," + Location Data.Longitude + ",1003)"

A piece of JavaScript to form the update clause to follow the set keyword in the case of an update.

Where

JavaScript

"id = "+Location Data.TransportID

A piece of JavaScript that is used for the WHERE clause.

 

 

Event proximity work in the Design widget

The event must always generate the action to update the transport's location, as shown in Figure 33.


Figure 33. Interaction for storing location
Interaction for storing location

 

 

Event proximity testing

For the scenario project, choose the Position update for storage event template, then enter a position update for an existing transport, as shown in Figure 34.


Figure 34. Position update event
Position update event

The resulting action shows the database update, as shown in Figure 35.


Figure 35. Position update action
Position update action

You can also see the effect on the transports table in Listing 15.


Listing 15. Selecting from transports

SELECT
      id,
      name,
      CAST(DB2SE.ST_X(location) AS DECIMAL(10,2)) AS latitude,
      CAST(DB2SE.ST_Y(location) AS DECIMAL(10,2)) AS longitude
FROM transports;
 
4 Rows returned:
 
ID   NAME                        LATITUDE          LONGITUDE
--   ----                        --------          ---------
1    Southampton Harbour Patrol  50.80             -1.50
2    Southern Skylark            50.31             -1.15
3    Rolling Thunder             50.80             -1.53

4    Southampton Harbour Patrol2 50.78             -1.30

 

To create a new record, enter a position for a new transport not already present in the transports table, as shown in Figure 36.


Figure 36. Position event for insert
Position event for insert

Sending this event will create a new row in the transports table as shown in Listing 16.


Listing 16. Selecting from transports with new row

SELECT
      id,
      name,
      CAST(DB2SE.ST_X(location) AS DECIMAL(10,2)) AS latitude,
      CAST(DB2SE.ST_Y(location) AS DECIMAL(10,2)) AS longitude
FROM transports;
 
5 Rows returned:
 
ID   NAME                        LATITUDE          LONGITUDE
--   ----                        --------          ---------
1    Southampton Harbour Patrol  50.80             -1.50
2    Southern Skylark            50.31             -1.15
3    Rolling Thunder             50.80             -1.53
4    Southampton Harbour Patrol2 50.78             -1.30

5    Harold Helicopter           50.90             -1.59

 

 

 

Calculating the proximity to an incident

This scenario considers which transports are near an incident. Incidents will have a location, some text and a distance from the source of the incident that can be used to notify nearby transports.

 

 

Incident proximity database queries

You can use a very similar query to the one used for distances to places to obtain comparisons with stored incidents or events, as shown in Listing 17.


Listing 17. Transport proximity select

SELECT
    transports.id
  FROM transports
  WHERE DB2GSE.ST_DISTANCE(
    DB2GSE.ST_POINT(50.90,-1.42,1003),
    transports.location,'METER') < 20000;

 

 

Note: When using the METER unit in a query, spatial indexes are not used. You might want to replace the query with a coarse grain look-up that uses degrees as a distance measure that will cause the query to use the index. However, for simplicity we have not used this approach in the example project.

An example of an optimised distance query is shown in Listing 18.


Listing 18. Optimised transport proximity select
SELECT
    transports.id
  FROM transports
  WHERE DB2GSE.ST_DISTANCE(
    DB2GSE.ST_POINT(50.90,-1.42,1003),
    transports.location,'METER') < 20000
   AND
    DB2GSE.ST_DISTANCE(
    DB2GSE.ST_POINT(50.90,-1.42,1003),

    transports.location) < 0.5;

 

Using the scenario project, when an incident is received that is within range of the stored transports and when any other criteria specified are met, the status of a transport is updated in the transport_status table, as shown in Listing 19.


Listing 19. transport_staus table definition

CREATE TABLE transport_status
(id SMALLINT NOT NULL,
 status VARCHAR(50));

 

 

 

 

Incident proximity work in Design Data

Now we want to record the latest incident that relates to a transport in the status table. Figure 37 shows how this is achieved by calculating the distance of all transports from the incident that are within the Range in meters value, using the mapped expression to identify the transports and the SQL expression to calculate the distance.


Figure 37. Incident proximity mappings and field constructors
Incident proximity mappings and field constructors

First a SQL expression is used to retrieve the transport IDs that are affected by the incident, as shown in Figure 38.


Figure 38. SQL expression for affected transports
SQL expression for affected transports

Using this transport ID the distance is then calculated to the incident, as shown in Figure 39. This step may be required or optional, depending on the application.


Figure 39. SQL expression for distance calculation
SQL expression for distance calculation

Next you need to updated the transport_status table with the RDBMS action connection (select the RDBMS template) by configuring the Store Transport Incident action. The action connection is configured to perform an update, with the option to perform an insert if no rows are found first, implementing an upsert, as shown in Figure 40.


Figure 40. Action connection upsert configuration
Action connection upsert configuration

It's important to tick the Automatically generate multiple actions property of the Store Transport Incident action to ensure that multiple actions are created per matching transport, as shown in Figure 41. This way, multiple inserts or updates are performed to the incidents table.


Figure 41. Generate multiple actions per action object
Generate multiple actions per action object

The Maximum Occurrences property setting should be set to 1 for both the TRANSPORT_STATUS and _Rdbms action objects to ensure that pairs of these objects are created as individual actions.

 

 

Incident proximity work in the Design widget

The Proximity to Another Event interaction set in the scenario project responds to an incident event and produces an action that stores the matching incidents for the relevant transports in the transport_status table.

 

 

Incident proximity testing

Select the incident event template and create an incident event using the location of an existing place using a range large enough to cause the filter to evaluate for some of the transports in the database, as shown in Figure 42.


Figure 42. Example incident event
Example incident event

Sending the event results in three matching transports and, therefore, three subsequent actions that store the incident information, as shown in Figure 43.


Figure 43. Incident storage actions
Example incident event

Selecting FROM transport_status, as shown in Listing 20, shows the incidents stored for each relevant transport. The id field corresponds to the id of the affected transport and the status text shows the text of the incident, the related incident identifier, and how far that transport is from the incident in metres.


Listing 20. transport_status selection

SELECT * FROM transport_status
 
3 rows returned:
 
ID     STATUS
--     ------
1      Docks closed [1: 14215 meters]
3      Docks closed [1: 17317 meters]

4      Docks closed [1: 15978 meters]

 

 

 

Visualisation with ILog JViews Maps

The example visualisation of transports and places uses a modified sample from ILog JViews Maps 8.7, provided for download, called jsf-maps-tiled. Running the web page using an Apache Tomcat server, we were able to render the locations and status of the transport data using the transports_visual view. You can also use WebSphere Application Server for visualisation, given the correct configuration and Java™ Server Faces implementation.

In our example, incident events that are sent to the project where the incident text starts with 1, 2 or 3, indicate that the visualisation should present the incident as critical, major, or minor, respectively.

The resulting Store Transport Incident actions write to the transport_status table. Figure 44 shows the resulting visualization in the transport_visual view.


Figure 44. Visualising incidents
Visualising incidents

Figure 45 shows the incident text above the symbol for Rolling Thunder and a red icon indicating that a critical event has occurred within the threshold range of this transport.

The steps required to set up the example visualisation are described in the next section. Also, the video demo provided for download shows the example incident event being fired and the effect on the visualisation.

 

 

 

Solution walk-through

Refer to the Downloads section for all files relating to the solution and example scenario project.

The following sections describe steps for defining the example DB2 database using spatial extensions, connecting the example Events project, publishing the project and setting-up the example visualisation.

 

 

Set up DB2

To set up the example scenario database for DB2, do the following:

  1. Open a DB2 command line and create the spatial database using the comman: db2 -t -f db_create_script.sql. This creates a database called SPATIAL to enable you to work with spatial types.
  2. Stop and restart DB2.
  3. From the DB2 control center, right-click the SPATIAL database.
  4. Select Spatial Extender => Enable.
  5. Select the SPATIAL_8K_TS tablespace. Leave the other options blank.
  6. Run the db_spatial.sql script to set up the tables and example data used in the example scenario project.

 

 

Connect the Business Events project to DB2

To connect the Business Events project to DB2, do the following:

  1. Open the LocationAwareBEP_DB2.xml project with Business Events Design Data.
  2. Right-click the Spatial hosted database source in Data Sources and select Properties.
  3. Modify the connection to match your environment and make sure you can see the tables and views that form part of the scenario.

 

 

Publish the project

To publish the project, do the following:

  1. With the project open in Design Data, choose File => Save as project to server store, then click Save.
  2. To open the Design widget in Business Space, point your browser to the Business Space URL (for example, http://localhost:9080/BusinessSpace), log in and navigate to the Design widget.
  3. Open the LocationAwareBEP_DB2.xml file as a project in the Design widget.
  4. Select Runtime => Publish to runtime.
  5. Start the Connectors for Business Events so Business Events can write to the SPATIAL database for actions fired from the incident event and transport update event.
  6. You can now use the Tester widget to fire example event data into your project. See the provided video for exact steps and example data.

 

 

Set up visualisation

Setting up the visualisation for the example project requires that you be able to run the samples from ILOG JViews maps using the Tomcat application server provided with ILOG JViews. You'll find all files mentioned here in the Downloads section.

  1. Make a copy of the jsf-maps-tiled folder for safe keeping. An example location is C:\Program Files\IBM\ILOG\jviews-maps87\samples.
  2. Copy world.jsp into the \webpages folder under \jsf-maps-tiled.
  3. Copy wbe.idpr and wbe.css into the \data folder under \webpages in \jsf-maps-tiled.
  4. Copy newpalette.jar and newpalette2.jar to the location mentioned in wbe.css; for example, C:\.
  5. Execute the clean.bat and build.bat batch files to rebuild the jsf-maps-tiled.war file.
  6. Run the Tomcat server to reload the sample WAR files. This should pull in your newly built jsf-maps-tiled.war file.
  7. Browse to the jsf-maps-tiled sample and use the controls to zoom into the south of England and find the symbols rendered on the map. Note that in order to refresh the visualisation of the symbols on the map, you'll have to choose an empty map using the drop-down on the web page, click OK, then choose the WBE example again.

 

 

 

 

 

Other spatial databases

Other spatially capable database variants can be used with WebSphere Business Events simply by adapting the same queries. The following section describes how the queries can be adapted to work with Oracle Spatial.

 

 

Oracle Spatial

The SQL used in the DB2 example can be adapted to work with Oracle Spatial. For example, a point type constructed from latitude and longitude values is represented as shown in Listing 21, where 2001 is a point type geometry as defined by Oracle Spatial.


Listing 21. Oracle spatial point type

SDO_GEOMETRY(
      2001,
      NULL,
      SDO_POINT_TYPE(<longitude value>, <latitude value>, NULL),
      NULL,

      NULL)

 

Any field in a table using an Oracle spatial type must be added to the user_sdo_geom_metadata table, and the definition of the geometry type must be provided. Listing 22 defines a simple 200 by 200 grid for the location field of the transports table. For mapping values onto a world map, the SRID value would need to be relevant to the type of geometry required for accurately mapping positions.


Listing 22. Oracle spatial metadata entry

INSERT INTO user_sdo_geom_metadata
    (TABLE_NAME,
     COLUMN_NAME,
     DIMINFO,
     SRID)
  VALUES (
  'transports',
  'location',
  SDO_DIM_ARRAY(   -- 200X200 grid
    SDO_DIM_ELEMENT('X', 0, 200, 0.005),
    SDO_DIM_ELEMENT('Y', 0, 200, 0.005)
     ),
  NULL   -- SRID
);

 

 

Oracle also requires that an index be created on any spatial type in order to construct queries using it, as shown in Listing 23.


Listing 23. Oracle spatial index

CREATE INDEX transports_idx
   ON transports(location)
   INDEXTYPE IS MDSYS.SPATIAL_INDEX;

 

 

 

 

 

Conclusion

In this article, you learned how you can use WebSphere Business Events to enable location-aware business event processing, using real-world examples that implement geofence detection and proximity alerting.

 

 

 

Downloads

Description

Name

Size

Download method

WBE project XML file and DB2 scripts1

wbe_project_and_database_setup.zip

11KB

HTTP

Ilog Jviews Maps setup files2

jsf-maps-tiled.zip

46KB

HTTP

Video demo3

wbe_location_aware_video.zip

11132KB

HTTP

 

 

 

Notes

  1. Contains the WBE project implementation to be connected to DB2 using Design Data. The DB2 scripts can be used to set up the database, including seeded data and example queries.
  2. Contains only the files required to replace the sample files in the jsf-maps-tiled visualisation example in order to visualise the example scenario data from the DB2 set-up scripts, and subsequent updates to it from any actions fired by the WBE project.
  3. Contains an mp4 format video and embedded web player showing an example event and actions with visualisation.
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Introduction

The objective of this article is to show you how to create a process design in WebSphere Business Modeler and test the process design on a test server. For this article, you can use the integrated test server that is provided with WebSphere Integration Developer, although you could also use a standalone server for testing purposes.

First you'll create a process design in WebSphere Business Modeler, initially with three human tasks, and test it on the server. Once the process design is complete, you'll add monitoring elements and test these on the server. Next you'll select built-in metrics for process and activity durations, and test these. Then you'll add other monitoring elements such as instance metrics, aggregate metrics, dimensions and KPI’s.

 

 

Prerequisites

You'll need the following software to complete this article.

  • WebSphere Business Modeler Advanced Version 7.x
  • WebSphere Integration Developer Version 7.x with integrated test server (WebSphere Process Server augmented with WebSphere Business Monitor server)

You also need to download the sample provided with this article and unzip it to a folder, such as C:\Labfiles.

 

 

Interactive process design

Interactive process design enables business users to quickly deploy and test their business processes without enlisting the services of the IT group.

For a human-centric business process, the business user is can step through the tasks, providing the input using Lotus® Forms. While completing the tasks, the user can review the data values for the inputs and outputs.

Numerous components are involved in interactive process design. WebSphere Business Modeler is used to create the business model and initiate the interaction. WebSphere Process Server is where the business process runs. If business monitoring is used, WebSphere Business Monitor is used to run the monitoring model.

The next big piece of the solution is WebSphere Business Space, which is used to manage the user interactions. Business Space has widgets for the interactive test environment and business monitoring. These widgets are supplied with the respective products.

WebSphere Service Registry and Repository is not required until you're ready to invoke external services from your business process. WebSphere Service Registry and Repository provides the facilities for doing dynamic endpoint lookup to locate the service implementation based on the interface name. If the endpoint information is known, then the service can be called directly from the business model. The service must be running and accessible through the network.

Forms are in integral part of a human-centric business process. They provide the mechanism for getting information to and from the application. Lotus Forms Viewer with the interactive process design feature is used for this. If you want to create more elaborate forms, you’ll need to use the Lotus Forms Designer.

To establish communication between WebSphere Business Modeler and the test server, you must create a server configuration file. Normally your IT department would create the test server and supply this file to you. For this article, you'll use the integrated test server in WebSphere Integration Developer and create the configuration file yourself. The configuration file is a list of the components to be used, such as Business Space, Process Server, Monitor Server and the role mapping file.

Testing on the server invokes the interactive test environment in the Business Space dashboard. You can step through the business process by filling out and submitting forms, watching the execution trace and inspecting the data values for each step.

 

 

Create users and groups in the server

In this section, you'll use the administrative console to add users and groups to the server. The groups are directly related to the roles that you create in the process design. An Associate role is used in the process design so you need the Associate group in the user registry.

  1. Log onto your server.
  2. Log on to the administrative console; for example, https://localhost:9043/ibm/console .
  3. Expand Users and Groups and click Manage Groups.
  4. On the Manage Groups page, click Create.
  5. Specify a group name of Associate, and provide an optional description, as shown in Figure 1.

    Figure 1. Specify group name
    Specify group name
  6. Click Create at the bottom of the page.
  7. Click Close.
  8. Select Manage Users under Users and Groups.
  9. Click Create, and specify Tom for User ID.
  10. Click Group Membership.
  11. On the Group Membership page, accept the default values and click Search.
  12. Select Associate under Matching groups and click Add, as shown in Figure 2.

    Figure 2. Specify group membership
    Specify group membership
  13. The Associate group will be moved under Current groups. Click Close.
  14. On the Create a User page, specify the following values to finish creating the user:
    • First Name: Tom
    • Last Name: Thumb
    • Password: <password>
    • Confirm Password: <password>
  15. Click Create.
  16. Select Administrative User Roles under Users and Groups, and click Add.
  17. Specify the following information, as shown in Figure 3:
    • For Role(s), select Administrator and Deployer (use the Ctrl key for multiple selections).
    • Enter Tom for the search string, then click Search.
    • Click Tom in the Available list and click the right arrow to move Tom to the Mapped to role list.

      Figure 3. Mapping user roles
      Mapping user                                         roles
  18. Click OK and then Save. You should see Tom listed with roles of Administrator and Deployer, as shown in Figure 4.

    Figure 4. User added with administrative roles
    User added with administrative roles

 

 

Edit the server configuration file

The server configuration file is used to identify the test server to WebSphere Business Modeler. You need to edit the server configuration file to set the member mapping file name. You'll create the member mapping file later in this article. You also need to set the host name and port numbers for the Process Server, Monitor Server and Business Space in the server configuration file.

  1. From your Windows® explorer, navigate to C:\Labfiles (or wherever you saved the downloadable sample) and open configuration_security.xml with a text editor.
  2. Add the memberMapping attribute after the secured attribute as shown in Figure 5. Also ensure that the host name and port numbers match those of your server.

    Figure 5. Modify server configuration file
    Modify server                                         configuration file
  3. Save and close the file.

 

 

Open the workspace and build the process design

In this section, you'll create the design for a simple process based on human tasks.

  1. Start WebSphere Business Modeler with a new workspace.
  2. Specify a name for the workspace, such as c:\workspaces\ipd.
  3. Close the Getting Started tab.
  4. From the icons menu at the top, click the Apply 4-Pane Layout icon ().
  5. From main menu, select Modeling => Mode => WebSphere Process Server to set the mode to WebSphere Process Server.
  6. Create a new project as follows:
    1. Right-click in the project tree and select New => Business Modeling Project.
    2. Specify DoSomething for New project name.
    3. Make sure that Create process is checked, and enter RequestWork for Name, then click Finish as shown in Figure 6.

      Figure 6. Create new project
      Create new project
  7. Create a new business item as follows:
    1. In the project tree, right-click Business Items.
    2. Under DoSomething, select New => Business Item.
    3. Specify the name of the business item as WorkRequest, as shown in Figure 7. Specify business item name
    4. Click Finish.
  8. Click Add under Business item attributes.
  9. For Name, replace Attribute with Work Item Number.
  10. Change the type from Text to Integer. You've now finished adding the first field, Work Item Number, of type Integer.
  11. Complete the same steps to add the attributes shown in Figure 8.

    Figure 8. Add business item attributes to WorkRequest
    Add business item attributes to WorkRequest
  12. Save and close the WorkRequest business item.
  13. Create a Resource catalog as follows:
    1. In the project tree, expand DoSomething, right-click Resources and select New => Resource Catalog.
    2. For Name of new resource catalog, specify WarehouseCatalog and click Finish.
  14. Create a role called Associate and assign a color to it as follows:
    1. Right-click WarehouseCatalog and select New => Role.
    2. For Name of the role, enter Associate.
    3. Click the grey box next to Color and select the color you want, then click OK and Finish. You'll see the new Associate role in the tree, as shown in Figure 9.

      Figure 9. Associate role in project tree
      Associate                             role in project tree
  15. Close the Associate window.
  16. Open the RequestWork process by expanding Processes and double-clicking RequestWork.
  17. Add three local human tasks as follows:
    1. In the Palette, click Human Task and then click the empty canvas.
    2. Type over the default name Human Task and replace it with Create work request, as shown in Figure 10.

      Figure 10. Add a human task
      Add a human                     task
  18. In the same manner, add two more human tasks: Prepare environment and Review quality.
  19. Add a connection from the process input to the input of Create work request by clicking the grey border line of the canvas, and moving the pointer to the Create work request task, and clicking again, as shown in Figure 11. This creates a connection with the default business item.

    Figure 11. Add a connection to the process input
    Add a connection to                     the process input
  20. Now update the business item as follows:
    1. Click the connection and select the Attributes tab on the bottom pane.
    2. On the General tab, scroll down and select Browse next to Associated data.
    3. In the Type Selection dialog, click Complex type.
    4. Select DoSomething => Business items => WorkRequest, and click OK. Your process diagram should now have the connection shown in Figure 12.

      Figure 12. WorkRequest business item on the connection
      WorkRequest business                     item on the connection
  21. Use the same process to add the following connections:
    • A connection from the Create work request human task to the Prepare environment human task, and assign the WorkRequest business item as Associated data.
    • A connection from the Prepare environment human task to the Review quality human task and assign the WorkRequest business item as Associated data.
    • A connection from the Review quality human task to the end of the process and assign the WorkRequest business item as Associated data.

Note: You may find it helpful to right-click the diagram, and select the Compact Diagram menu option to move the right border close to the nearest human task.

  1. Figure 13 shows the diagram with all three tasks and their connections.

    Figure 13. Diagram with three tasks and connections
    Diagram with three                     tasks and connections
  1. Assign a primary owner to the Create work request human task as follows:
    1. In the process editor, highlight Create work request and then select Attributes in the bottom pane.
    2. Select the Primary Owner tab and then click Role.
    3. Click Browse next to Role and then select DoSomething => Resources => WarehouseCatalog => Associate from the Select Role Requirement dialog.
    4. Click OK to return to the Attributes pane.
    5. Make sure that Members by role name is selected for Name and Associate is the Attribute value in the table, as shown in Figure 14.

      Figure 14. Primary owner attributes
      Primary owner                     attributes
  1. Repeat the previous step for the Review quality human task and assign Associate as the primary owner.
  2. For the purpose of this article, let's assume that the Prepare environment task will eventually be implemented by a service but for now it will be simulated as a human task. Leave the primary owner information as the default. This means the owner at runtime will be everybody, which means that Tom or any other user can claim the task. Add an annotation to the task to indicate that this is a placeholder human task to be implemented later by doing the following:
    1. In the palette, click Annotation and then click below the Prepare environment human task to place the annotation under it.
    2. Type This is the placeholder human task for the service that will be implemented in a subsequent exercise.
    3. Add a connection from the annotation to the Prepare environment human task, as shown in Figure 15.

      Figure 15. Add annotation
      Add                     annotation
  3. From the icons menu of the RequestWork process window, click the Color by icon and select Role, as shown in Figure 16.

    Figure 16. Select Color by Role
    Select Color                     by Role
  4. Click the Color by icon again and select Show Color Legend. Your process diagram should look similar to Figure 17.

    Figure 17. Process diagram
    Process                     diagram
  5. Save your changes and close the process editor.
  6. Finally, you need to export the user role information into an rmf file. The rmf file is referenced by the server configuration file. To create deployable business processes using WebSphere Business Modeler, the primary owner for a human task must be specified using a role. Before the business analyst assigns roles to human tasks, you need to ensure that the roles correspond to groups in your people directory. When you deploy the business process application, WebSphere Process Server requires a role mapping file to map roles to these groups in the people directory. Export the role information as follows:
    1. In the WebSphere Business Modeler Project Tree, right-click DoSomething select File => Export.
    2. In the Export window, select WebSphere people directory data, and click Next.
    3. For the target directory, click Browse and select C:\Labfiles (or wherever you saved the downloadable sample. You should verify that this folder contains configuration_security.xml.
    4. Make sure that the project is DoSomething.
    5. For the export file name, specify DoSomething_Users_Roles.
    6. Click Finish. The rmf extension is automatically appended to the exported file.
  7. Update the role file with the new uniqueName as follows:
    1. Earlier you created the users and groups on the server. You created user Tom in group Associate. The IT group would normally do this for you and give you the unique name of the group in the people directory; in this case cn=Associate,o=defaultWIMFileBasedRealm.
    2. In your file explorer, navigate to the directory where you exported the DoSomething_Users_Roles.rmf file (for example, C:\Labfiles) and open the file with a text editor.
    3. Update the value of the uniqueName attribute of the Associate role as follows:
<?xml version="1.0" encoding="UTF-8"?>
<logicalmapping:LocationEntityRoot mlns:logicalMapping=
        "http:///www.ibm.com/logicalMapping"
peopleDirectory="bpe/staff/samplevmmconfiguration">
        <role name="Resources/WarehouseCatalog/Associate"
uniqueName="cn=Associate,o=defaultWIMFileBasedRealm" 
        uid="BLM-$a0a22ef67c9b099d208719dbb67621ba"
description="" groupName="Associate"/>
</logicalMapping:LogicalEntityRoot>

 

    1. Save and close the file.

 

 

Test the process design

In this section, you'll test the process design on the test server. In Business Space, you'll step through the flow of the process and complete the human tasks.

  1. Add the Servers view to your modeling workspace as follows:
    1. Select Windows => Show View => Other.
    2. In the Show View window, select Business Modeler Views => Process Execution Environment, and click OK. The Process Execution Environment view will be added to the bottom pane.
  2. In the Process Execution Environment view, right-click Test Servers and select Add Server, as shown in Figure 18.

    Figure 18. Select Add Server
    Select Add                     Server
  3. In the Add Server dialog, provide the following values, as shown in Figure 20:
    • Configuration file: Browse and select the configuration_security.xml file
    • Account ID: Tom (the user you created earlier)
    • Password: <password>
    • Optionally, check Save the password, so that you don't have to enter it every time.



Figure 19. Specify server configuration details
Specify server                     configuration details

  1. Click OK. A new server will be added and listed in the servers view.
  2. Run the process on the server and check the Errors view, as shown in Figure 20. You should have only one warning and no errors. The warning message indicates that there is not a role assigned to the task Prepare Environment.

    Figure 20. Verify that there are no errors
    Verify that                     there are no errors
  3. In the Project Tree, expand Processes, right-click RequestWork, and select Verify Process Design, as shown in Figure 21.

    Figure 21. Verify process design
    Verify                     process design
  4. Click OK on the Show Future Errors dialog. The process deployment will take a few minutes.
  5. When complete, click OK in the Switch to Process Testing Environment window to open a process testing window.
  6. Log in to Business Space as Tom, as shown in Figure 22.

    Figure 22. Log in to Business Space
    Log in to                     Business Space
  7. Create a process instance as follows:
    1.  
    2. Select Work with Processes and then select the Start Process Instance widget.
    3. In the Start Process Instance widget, select RequestWork then select Actions => Create, as shown in Figure 23.

      Figure 23. Create process instance
      Create process                     instance

      A Request Work window opens in the Enter Data into Forms widget.
    4. Provide values as shown in Figure 24.

      Figure 24. Enter data into forms
      Enter data into forms
    5. Click Submit at the top of the widget.
  1. Scroll down to the Trace Process Execution widget and expand RequestWork => RequestWork Input Criterion to verify the details under it. The right pane shows the data input to the process, as shown in Figure 25.

    Figure 25. Trace process execution widget
    Trace process                     execution widget
  2. In the diagram in the same widget, shown in Figure 26, note the pop-up next to Create work request saying that the task is waiting. If the diagram is not displayed as you like, you can click to adjust the zoom level, or you can hover over the canvas until you see the hand cursor, then drag the diagram to reposition it in the widget.

    Figure 26. Trace process diagram
    Trace process                     diagram
  3. Claim the Create work request task by scrolling up to the Claim Available Tasks widget. You should see a new Create work request task. Select this task and then select Actions => Edit, as shown in Figure 27.

    Figure 27. Claim available tasks
    Claim                     available tasks
  4. Scroll up to the Enter Data into Forms widget to edit the output form. Enter the same values as before, but set the status to Created to show that the work for the task has been completed, and click Submit.
  5. Scroll down to the Trace Process Execution widget and expand select RequestWork => Create work request. The right pane shows the output for the task and you can see that the status is now Created.
  6. Scroll up in the Process Execution widget. As you can see in Figure 28, the Prepare environment human task is now waiting.

    Figure 28. Prepare environment task waiting
    Prepare environment                     task waiting
  7. To claim the Prepare environment task, scroll up to the Claim Available Tasks widget, select Prepare environment and then select Actions => Accept, as shown in Figure 29.

    Figure 29. Accept the Prepare environment task
    Accept the Prepare                     environment task
  8. Scroll up to the Enter data into Forms widget to edit the output form. Enter the same values as before, but set the status to Prepared to show that the work for the task has been completed, and click Submit.
  9. Scroll down to the Trace Process Execution widget and select RequestWork => Prepare environment. Note that the status is now Prepared.
  10. Scroll up in the Trace Process Execution widget. As you can see in Figure 30, the pop-up now shows that the Review quality human task is waiting to be completed.

    Figure 30. Review quality task waiting
    Review quality task waiting
  11. Claim the Review quality task by scrolling to the Claim Available Tasks widget, selecting Review quality, selecting Actions => Edit.
  12. Scroll up to the Enter data into Forms widget to edit the output form. Enter the same values as before, but set the status to Reviewed to show that the work for the task has been completed, then click Submit.
  13. Scroll down to the Trace Process Execution widget and select RequestWork => RequestWork Output Criterion. Note that the output for the process shows that the status is now Reviewed.
  14. Scroll up in the Trace Process Execution widget. As you can see in Figure 31, all three tasks have been completed.

    Figure 31. Process completion
  15. Log out and close the Business Space window.
  16. To remove the process from the server, from the Process Execution Environment view right-click the server, then select Delete Processes from Server, as shown in Figure 32.

    Figure 32. Delete processes from the server
    Delete processes                     from the server

 

 

Add processing time metrics for monitoring

In this section, you'll add monitoring metrics to the process design. Initially, you'll only add metrics to track the processing times for the process and the human tasks. Later, you'll add other metrics and key performance indicators (KPIs) for monitoring purposes.

  1. In WebSphere Business Modeler, open the RequestWork process.
  2. Add the Business Measures view as follows:
    1. From the menu, select Window => Show View => Other.
    2. From Business Modeler Views, select Business Measures. You should see the view added in the bottom pane.
  3. Click the white background of the RequestWork diagram to display the business measures for this process in the Business Measures view.
  4. In the Business Measures view, click the Monitored Values tab, then select the processing times for each of the listed elements, as shown in Figure 33.

    Figure 33. Business measures monitored values
    Business measures                     monitored values
  5. Click the Business Performance Indicators tab, as shown in Figure 34, and expand Instance Metrics and Aggregate Metrics. Notice that these metrics have been automatically created for you based on your selections on the Monitored Values tab.

    Figure 34. Business performance indicators
    Business performance                     indicators
  6. There are instance metrics for the processing times of the process and human tasks. There are also aggregate metrics based on these instance metrics to show the average processing times. An aggregate metric is typically based on a numeric instance metric and it applies a function to it. The functions can be average, count, minimum, maximum, sum, and standard deviation. The instance metrics can be viewed in the instance widget in business space. The aggregate metrics can be used with the Dimensions widget in Business Space. These metrics are ready to be deployed to the server and monitored using Business Space.
  7. To review the definitions of these metrics, double-click any one of them in the list. The metric editor opens. You can click any of the metrics in the navigation tree to see the details for it. Click the first instance metric.
  8. As shown in Figure 35, you can see that the instance metric is based on the elapsed duration built-in template, and the process element is also defined here.

    Figure 35. Instance metric details
    Instance metric                     details
  9. Click the first aggregate metric in the list.
  10. As you can see in Figure 36, the average function is selected and it applies to the specified instance metric.

    Figure 36. Aggregate metric details
    Aggregate metric                     details
  11. Close the business measures editor and save your changes.

 

 

Test the process design and check the monitored processing times

In this section, you'll test the process design on the server. You should see a new tab in the dashboard that displays monitor widgets where you can see the monitored processing times.

  1. Test the process on the server.
  2. Check the Errors view to ensure that you have no errors.
  3. In the Project Tree, expand Processes, right-click RequestWork, and select Verify Process Design.
  4. Click OK in the Show Future Errors dialog.
  5. The process deployment will take a few minutes. You may notice that it takes a little longer this time because the monitor model is also being deployed.
  6. When complete, click OK in the Switch to Process Testing Environment window to open a process testing window.
  7. Log in as Tom.
  8. Notice that there is now an additional tab in the dashboard for monitoring widgets, as shown in Figure 37.

    Figure 37. Business measures tab in the dashboard
    Business measures                     tab in the dashboard
  9. From the Processes tab, create and complete several process instances.
  10. Click the Business Measures tab. You should see the monitoring widgets.
  11. In the Instance Metrics widget, you can see the processing times for the overall process and the individual human tasks in the process, as shown in Figure 38.

    Figure 38. Instance metrics widget
    Instance metrics                     widget
  12. In the Dimensions widget, you can see the process instance count by creation time. You will need to resize the widget, so click the arrow in the upper right corner to open the menu, then click Resize and pick a size, such as 400. You should see a graph and table similar to Figure 39:

    Figure 39. Dimensions widget
    Dimensions widget
  13. You can drill down on the creation time by double-clicking All CreationTime in the column header to see the instance count by year, as shown in Figure 40.

    Figure 40. Drill down on creation time
    Drill down on                     creation time
  14. You can continue to drill down by double-clicking a specific year in the column header to see the count by year, as shown in Figure 41.

    Figure 41. Drill down on year
    Drill down on                     year
  15. You can drill down to individual days by double-clicking a specific month, as shown in Figure 42.

    Figure 42. Drill down on month
    Drill down on                     month

In the Business Measures editor, you can easily add other metrics, measures, dimensions and KPIs to the Business Measure model to monitor other information. For example you could create an instance metric to track the numeric field Quality Rating in the business object. You could then view this metric in the Instances widget in the dashboard. You could create a KPI which would be based on averaging the Quality Rating metric, and then you could see this KPI with current average value, target values and range values in the dashboard, as shown in Figure 43.


Figure 43. KPI widget
KPI widget

 

 

Summary

In this article, you developed and tested a process design with three human tasks. You also added built-in monitoring templates to monitor processing times and verified them in the monitor dashboard.
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Overview

WebSphere Business Compass provides a business document authoring environment for capturing your organization's business strategy, capabilities, and processes. But documents that are produced and never used are just dead weight in your organization. This article describes how the business design and implementation documents that are produced by one person or by a team working together can be made available for everyone in the organization to use in their everyday jobs.

The producers of documents in WebSphere Business Compass can share their content so that the rest of the organization can interact with it. The instructions for how to do this are slightly different depending on whether the producer is just you, your team, a few teams, or everyone in the company.

This article describes the following four common document-sharing scenarios:

  1. How do I create documents when I'm just playing or just getting started, and I don't want anyone else to see what I'm doing? (See Working alone and privately.)
  2. How do I work with a team when we all want to work together on documents and see each other's changes? (See Working in a team.)
  3. How do I share documents with other teams so they can see the work that I have done and continue to evolve it? (See Sharing documents across teams.)
  4. What if I have documents that I want to make publicly available within my organization for everyone to see and refer to? (See Using reference documents across the organization.)

 

Working alone and privately

Brian Bookman, the business analyst for a bookstore chain, has an idea for a new distribution process. He isn't sure if it's feasible yet, so he wants to play around with it and try it out.

On the WebSphere Business Compass home page, Brian selects Start to create a new business design space. He names the space Brian's Business Design World and clicks OK. His new work area opens and Brian selects Create to start creating business design documents.

Brian creates various documents, including a strategy map and a process, and then adds links between documents. Everything that Brian puts into his new space is visible only to him.

After a while, Brian realizes that he could use some information from a document he's been working on in another space. In the Documents tab at the top of the Design page, he selects Repository on the left. (Alternatively, he can select Search in the Share section of the toolbar.) To see a list of all the documents he owns, wherever they are, Brian clicks the arrow beside the search box and selects My Documents, as shown in Figure 1.


Figure 1. Searching for your own documents
Searching for your own                     documents

Brian selects Search and sees the list of all his documents. He selects the document he wants and clicks Add shortcut in the Share section of the toolbar to add the document to his space, as shown in Figure 2.


Figure 2. Adding a document to your space using a shortcut
Adding a document to your                     space using a shortcut

Alternatively, Brian can drag the document from the list of search results into Brian's Business Design World (above Repository on the left).

Now that Brian has added a document that he owns from another space, the changes that he makes in this document will be reflected when he views the document in the other space as well. The spaces provide different windows into the private documents Brian has stored in the repository.

 

 

 

Working in a team

In another part of the bookstore chain's head office, Lisa Leader is setting up a business space for her team. They are going to be working together on a set of documents required for a new product line.

Like Brian, Lisa selects Start on the Compass home page to create a new business design space. She names the space Special Chocolates Product Launch. Because she's assembling a team to work with her on this project, Lisa also enters a description that reflects the business goal for the team.


Figure 3. Adding a description to your space
Adding a description to                     your space

The new team work area opens and the description is visible on the Overview page. To make this space a shared work area, Lisa adds the rest of the members to the space. In the Team section on the Overview page, she clicks Add Members and begins to add the members of her team. She enters part of each name and clicks Search to find each team member. She checks beside each name and clicks OK to add the team member to the space, as shown in Figure 4.


Figure 4. Adding a team member to your space
Adding a team member to                     your space

Everyone that Lisa adds to the space can edit any documents created in that space.


Figure 5. List of team members on the Overview page
List of team members on                     the Overview page

Lisa clicks the Design tab to start creating documents. All the documents she creates are editable by all members of her space, but only one person can edit a document at a time. When one person has a document open for editing, the rest of the team can view the document but cannot change it.

By default, the creator of a document is its owner. The owner of the space also owns all documents. On the Design page, you can see the owners of each document in a space by clicking the arrow and selecting the Owners column, as shown in Figure 6.


Figure 6. Adding the Owners column to the list of visible columns
Adding the Owners column                     to the list of visible columns

As people on the team create documents, all the documents show up on the Design page and can be edited by anyone who is part of the team. At this point, only members of the team can see the documents that were created within the space.

 

 

 

Sharing documents across teams

Brian, the business analyst, has been developing a capability map that structurally describes the functional capabilities available within the organization. Lisa would like to refer to this document while she works on her new project, to see if there are capabilities that her new project can use. She asks Brian if she can take a look at his map.

Brian likes the idea of getting Lisa's feedback on his capability map. To give Lisa access to the document, he goes to his Business Design Home (by clicking Home in the top left of the screen) and then clicks the Document Access Control page.

On the Document Access Control page, Brian selects the capability map and clicks Add Owner, as shown in Figure 7.


Figure 7. Adding an owner to a document
Adding an owner to a                     document

Brian checks Lisa's name to add her as an owner of the document. Notice in Figure 8 that he can also see the spaces that have edit access to the document.


Figure 8. A document with two owners on the Document Access Control page
A document with two owners                     on the Document Access Control page

Back in her Business Design space, Lisa goes to her Documents tab on the Design page and clicks Repository. (Alternatively, she can click Search in the Share section of the toolbar.) She clicks the arrow beside the search box and selects My Documents to see her own documents. When she clicks Search, she sees Brian's capability map in the list because he has added her to the list of owners for the document.

Lisa selects the map and clicks Add shortcut in the Share section of the toolbar to add the map to her team's space. Alternatively, she could drag the map from the list of search results into the space.

By default, the document is read-only when Lisa pulls it into her space, which means that none of her team members can make changes to the document. The document shows a key icon to indicate that it cannot be modified. In addition, instead of the usual Edit | View buttons that normally show up when Lisa hovers over the name of a document, Lisa and her team see only View, as shown in Figure 9.


Figure 9. A document showing the key icon and View button
A document showing the key                     icon and View button

Lisa clicks View to open the capability map. Because she is now an owner of the document, she can click Edit within the document to begin making changes. When she does so, she sees a message reminding her that her whole team has the same access to the documents in this space as she does. If she clicks Edit, she is giving edit access to her whole team.


Figure 10. Warning message to the document owner
Warning message to the                     document owner

If Lisa clicks Edit and later changes her mind, she can select the capability map on the Document Access Control page, select her space from the list of spaces with access to it, and click Revoke Space Access. The document will still be there and her team will still be able to view it, but they will no longer be able to edit it.

On the other hand, if Lisa has been using the capability map in read-only mode and has not edited it, and members of her team open the document, they cannot edit it either. They see a Request edit access button rather than the Edit button that Lisa, as an owner of the document, sees.


Figure 11. Button to request edit access
Button to request edit                     access

Larry, a member of Lisa's team, clicks Request edit access to request access. He's prompted to enter the reason for his request.


Figure 12. Entering a reason for the edit access request
Entering a reason for                     the edit access request

After Larry enters his reason and clicks OK, he sees the message "A request to edit this document has been sent to the document owner."

Both Lisa and Brian receive an email informing them of Larry's request. By requesting edit access to the document, Larry is requesting edit access for all members of his team. Brian, as the document owner, must decide whether he wants to control access to the document and make all the changes himself, or whether he wants to allow all the members of Lisa's team to make changes.

Brian decides to grant edit access to Lisa's team. He goes to the Documents Access Request page in his Business Design Home space and sees Larry's request there. He selects the document in the list and clicks Accept.

 

 

 

Using reference documents across the organization

Lisa's team has now created some new process maps that they're ready to make available to everyone in the organization. Lisa clicks one of the documents, and in the Share section of the toolbar, clicks Make Document Public, as shown in Figure 13.


Figure 13. Making a document public
Making a document                     public

Lisa sees a message confirming that she wants users in all Business Design spaces to be able to see her process map. When she clicks OK, the current version of the process map is published.


Figure 14. Confirmation message
Confirmation                     message

The document is now available for everyone in the organization to use, but Lisa can continue to evolve the document. Others won't see her changes until she chooses to make the document public again. When she does that, the new version will replace the previous version.

Brian Bookman, still working on his ideas for the new distribution process in his private workspace, realizes that he can make use of one of Lisa's new processes. In the Documents tab on the Design page, he clicks Search. Since he knows what type of document he's looking for, he selects Process Maps from the include list, as shown in Figure 15.


Figure 15. Narrowing down the search
Narrowing down the                     search

If he knew the name of the document, or part of it, he could also type that into the search box.

Brian clicks Search and sees a list of all the publicly accessible process documents, including Lisa's. He selects the one he wants and drags it from the list of search results into Brian's Business Design World. A link is created from Brian's private space to the process map. Brian can view the details of Lisa's process, but he cannot change it.

Brian also wants to use a term from the company's vocabulary document in the description for one of the new processes he is creating. In the process editor where he's working, he clicks the Search Vocabulary icon, which launches the vocabulary search window, as shown in Figure 16.


Figure 16. Finding a definition
Finding a definition

Brian types the term he's looking for and clicks Search. WebSphere Business Compass searches for a matching term in all public vocabulary documents.

Unlike Lisa's process map, which Brian brought into his space to round out his own content, Brian does not pull the vocabulary document into his space. He just needs to refer to the definition from his process.

 

 

 

Conclusion

The documents produced in WebSphere Business Compass can be kept private, shared only with a small team, shared with several teams, or made available for everyone in the organization to use in their everyday jobs. Many different sharing scenarios are possible, and you can decide the most appropriate level of access to provide depending on your organization and the context of your work.
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Introduction

A business process management project using a WebSphere business process management solution can be initiated by first modeling business processes using WebSphere Business Modeler and then implementing new services or integrate existing services within the business processes using WebSphere Integration Developer. However, this is seldom a one-way path to deployment for various reasons, for example, continuous process improvement and ever-changing business requirements. The lifecycle of such business process management projects usually involves iterative development between WebSphere Business Modeler and WebSphere Integration Developer.

This article discusses a few recommendations when modeling for runtime in WebSphere Business Modeler V7 that can make iterative development with WebSphere Integration Developer easier. There are guidelines for:

  • Minimizing the impact of model changes introduced in WebSphere Business Modeler to artifacts in WebSphere Integration Developer.
  • Modeling business processes in ways that make the comparison and merging of model changes easier.
  • Dealing with inline Web Service Description Language (WSDL) as definitions for business items and services.

 

 

Minimize the impact model changes

For any development process that involves hand-offs between two products, one of the most frequently asked questions is how to model and organize the artifacts so that the impact of model changes is minimal. Here are a few tips:

Use the Recommended Export Option

As shown in Figure 1, the WebSphere Business Modeler project is exported into three modules or libraries in WebSphere Integration Developer using the Recommended Export Option:

  • Business logic module
  • Implementation module
  • Library project

The business logic modules contain BPEL definitions directly transformed from WebSphere Business Modeler models; whereas the implementation modules contain “black box” constructs that require concrete implementation to be completed in Websphere Integration Developer.


Figure 1. WebSphere Business Modeler Export dialog
WebSphere Business Modeler Export dialog

 

 

Leverage the mediation flow component when calling external services

A task node can be a new service yet to be implemented or an existing service that needs to be integrated. You can leverage a mediation flow component in WebSphere Integration Developer to perform mapping to and from the external services to avoid having to update the process model each time the external service interface is changed. To create the mediation flow in WebSphere Integration Developer, make sure Create mediation flows for tasks and services is selected in the Export dialog.

Make business-driven changes WebSphere Business Modeler

Integration developers should modify the implementation modules only by refining the implementation details in these modules in WebSphere Integration Developer and leaving the business logic changes to be done by the business analysts in WebSphere Business Modeler.

If the change is business relevant, the user can update the execution model in Business Modeler, re-export the model, then synchronize in WebSphere Integration Developer using the Synchronization dialog to merge the changes between WebSphere Business Modeler generated artifacts and artifacts in the WebSphere Integration Developer workspace. For more information on using the Synchronization dialog to facilitate iterative development, refer to “Merging changes from the model into the workspace” in the WebSphere Integration Developer Information Center.

 

 

Modeling business processes to make merging of changes easier

The following sections describe some recommendations for business process modeling to make the comparing and merging of changes easier.

Decision nodes

By default, decision nodes in WebSphere Business Modeler generate BPEL links with transition conditions in WebSphere Integration Developer. In WebSphere Process Server mode, WebSphere Business Modeler provides the option to transform the decision node into a BPEL Switch activity, which is then transformed into choice node in the WebSphere Integration Developer Technical Attributes tab. However, this is generally not recommended.

The decision node in WebSphere Business Modeler depicts a graph-based process flow representation that conforms with BPMN notation, whereas a choice node in WebSphere Integration Developer requires each decision branch to be well-structured and self-contained. To maintain a better traceability between the WebSphere Business Modeler process and BPEL, it is recommended that you maintain a one-to-one mapping of the graph-based process flow. This facilitates a much smoother iterative development by reducing complexity in the comparing and merging in WebSphere Integration Developer.

Data flows and variables

There are two ways to specify data flow in WebSphere Business Modeler: Modeler-style and BPEL-style. Modeler-style specifies the data on the links, as shown in Figure 2; whereas BPEL-style uses a local repository, as shown in Figure 3.


Figure 2. Modeler-style data flow modeling
Modeler-style data flow                                         modeling

Figure 3. BPEL-style data flow modeling
BPEL-style data flow                                         modeling

Try to avoid mixing the two styles. WebSphere Business Modeler may generate a more complex BPEL if a mixture of styles is used, which may lead to redundant variables being passed around in the business process. It is generally more intuitive to use the Modeler-style data flow modeling. However, if you would like to have more control over the variable name, you should use the BPEL-style because you can specify variable name in BPEL using the Technical Attributes tab, as shown in Figure 4. You might think that defining a local repository will make the process flow look more cluttered, but WebSphere Business Modeler provides an option to hide the local repository so that the process diagram looks cleaner.


Figure 4. Technical Attributes tab of local repository
Technical Attributes tab of local                                         repository

Well-formed processes

A WebSphere Business Modeler process is a BPMN-based process graph. To transform the process to an executable BPEL process, the process branch regions must be sound and well-formed. For example, exclusive branches mixing with parallel flows creates a mixed process region that cannot be correctly merged or joined later in the process flow. Figure 5 illustrates such an example. Note that the last XOR merge node does not offer a valid synchronization point for the parallel gateway, nor can it be changed to an "AND" join node because this would create a potential deadlock situation for the exclusive gateway.

WebSphere Business Modeler has validation rules to validate the semantics of a process flow to ensure it is well-formed. The same set of validation rules are also used in the BPEL editor in WebSphere Integration Developer to ensure that the process logic is deployable and executable.


Figure 5. Mixed parallel and exclusive branch region
Mixed parallel and exclusive branch                                         region

 

 

Artifacts based on inline XSD/WSDL

When a WSDL has inline XSD, this means that other WSDL or XSD elements that reside outside the file cannot reference the inline types in that WSDL. For this reason, when importing WSDL with inline XSD into WebSphere Business Modeler, the business service objects become “private.” To link a task that references the inline types, you need to use the Map node to map the data of the business service defined by the “private” schema to and from other tasks or business services in the process.

An alternative is to extract XSDs out of WSDLs before import, so that there is no inline element in the WSDL. You can do this when exporting the WSDL in WebSphere Integration Developer, by selecting the option to extract the inline schema and create a standalone “public” schema. You can then import the WSDL and the standalone schema into WebSphere Business Modeler. However, this may not be ideal when the WSDL comes from a third party or the organization doing the business process modeling does not have control on the WSDL.

 

 

Conclusion

This article provided some recommendations for iterative development between WebSphere Business Modeler and WebSphere Integration Developer, including how to minimize the impact of model changes made in WebSphere Business Modeler to WebSphere Integration Developer, tips on modeling business processes, and things to look out for when dealing with inline WSDL/XSD as the business service and business service object definitions.
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Introduction

The content of this article is based on IBM studies and research to implement a complex event processing solution for a Fortune 500 company. The article is Part 1 of a series that discuss topics associated with the best approaches and techniques for implementing a highly available, highly scalable WebSphere Business Events infrastructure using WebSphere MQ Server V7 as the messaging backbone to interact with WebSphere Message Broker.

When configuring and setting up Websphere Business Events (hereafter called Business Events), one of the steps is to augment the Business Events profile with Business Space. The Business Events Information Center provides instructions on how to augment a Business Events profile with Business Space for a standalone Business Events server. In this article, we'll describe the steps required to augment a Business Space in a Business Events clustered environment.

All sample commands demonstrated in this article are based on WebSphere Business Events V7.0.1 and WebSphere Application Server V7.0.0.7.

 

 

Infrastructure overview

Figure 1 shows an example of a highly available and scalable Business Events infrastructure cluster configured horizontally with two physical machines. The Business Events data store and Business Space tables are configured remotely and reside in third machine.


Figure 1. Business Events infrastructure cluster example
Business Events infrastructure cluster example

The Business Events cluster resides inside a WebSphere Application Server (hereafter Application Server) cell. A Business Events Service Integration Bus with one active message engine uses WebSphere MQ as the JMS provider. The Business Events cluster is augmented with Business Space.

The following sections detail the steps for augmenting Business Events with Business Space.

 

 

Prerequisites and set-up

These instructions assume you have previously installed the Business Events runtime into an Application Server cluster called WBECluster. You can define the cluster with a name of your choice, just make sure to change the properties in the instructions below to reflect the name used.

Note: Defining a cluster is beyond the scope of this document. Refer to the WebSphere Application Server Information Center or the WebSphere Business Events Information Center for more information.

 

 

Step 1: Augment the Deployment Manager profile with the Business Space template for Business Events

1.      Log in to the machine hosting your Deployment Manager as root

2.      Make a backup copy of the following file.
/opt/IBM/WBE701/WAS/BusinessSpace/config.bspace/MetadataFiles/BSpace_DB2-distributed.properties

3.      Modify the original file as follows, substituting your implementation-specific information for the items in italics.

 

# ====> Set wasHome to the WAS install root directory <====
wasHome=/opt/IBM/WBE701/WAS 
#====> Set databaseUser to the user ID of a user with database privileges <==== 
databaseUser=db2inst1
# Properties used to create the data source 
# - serverName
# ====> Set serverName to the name of the database server host<====
serverName=your DB server name 
# - Set portNumber to the database server port
portNumber=60000
#====> Set db2universal_jdbc_driver_path to appropriate directory<====
db2universal_jdbc_driver_path=/opt/IBM/WBE701/WAS/universalDriver_wbi/lib
# - universal_jdbc_driver_path identifies the location of db2jcc_license_cu.jar # 
====> Set universal_jdbc_driver_path to the appropriate directory<====
universal_jdbc_driver_path=/opt/IBM/WBE701/WAS/universalDriver/lib

                                       

4.      From the Application Server install/bin directory, issue the following command:

 

./manageprofiles.sh -augment -profileName Dmgr01
-templatePath
"/opt/IBM/WBE701/WAS/profileTemplates/BusinessSpace/dmgr.bspace"
-cellName conaix11Cell01 -nodeName
conaix11CellManager01 -bspacedbDesign
/opt/IBM/WBE701/WAS/BusinessSpace/config.bspace/MetadataFiles/BSpace_DB2-
distributed.properties -dbDelayConfig true

5.      You should see the following response:  NSTCONFSUCCESS: Profile augmentation succeeded.

 

Note that we are opting to delay the database configuration (-dbDelayConfig true). This is necessary because our business space database is in a remote location.

 

                                             

Step 2: Install Business Space components

  1. Log in to the machine hosting your Deployment Manager.
  2. From the Application Server install/bin directory, start the the administration configuration tool by issuing the command: wsadmin.sh.
  3. Issue the following command to install the Business Space components: $AdminTask installBusinessSpace {-clusterName WBECluster}
  4. Save the changes by typing the command: $AdminConfig save.
  5. Issue the following command to configure the database scripts and JDBC resources:
    $AdminTask configureBusinessSpace {-clusterName WBECluster -bspacedbDesign
    /opt/IBM/WBE701/WAS/BusinessSpace/config.bspace/MetadataFiles/BSpace_DB2-distributed.properties}
  6. Save the changes by entering the command: $AdminConfig save.
  7. Type quit to exit the administration tool.

 

 

Step 3: Verify the installation

  1. Change to the Deployment Manager profile directory. You should now see both a BusinessSpace directory and a dbscripts directory.
  2. The dbscripts directory contains several scripts and SQL configuration files that are required to build the Business Space Parms database on the remote database server, as shown below:

 

[root@conaix11]/opt/IBM/WBE701/WAS/profiles/Dmgr01/dbscripts/BusinessSpace/
WBECluster/DB2/BSPACE> ls -l
total 160
-rw-r--r--    1 root     system         2351 Sep 17 15:00 configBusinessSpaceDB.bat
-rwxr-xr-x    1 root     system         2638 Sep 17 15:00 configBusinessSpaceDB.sh
-rw-r--r--    1 root     system         1945 Sep 17 15:00 createDBTables.bat
-rwxr-xr-x    1 root     system         1574 Sep 17 15:00 createDBTables.sh
-rw-r--r--    1 root     system          984 Sep 17 15:00 createDatabase.sql
-rw-r--r--    1 root     system         3044 Sep 17 15:00 createGrant.sql
-rw-r--r--    1 root     system         1099 Sep 17 15:00 createSchema.sql
-rw-r--r--    1 root     system        18997 Sep 17 15:00 createTable.sql
-rw-r--r--    1 root     system         1881 Sep 17 15:00 createTables_BusinessSpace
.sql
-rw-r--r--    1 root     system         2119 Sep 17 15:00 createTablespace.sql
-rw-r--r--    1 root     system         1122 Sep 17 15:00 dropSchema.sql
-rw-r--r--    1 root     system         2082 Sep 17 15:00 dropTable.sql
-rw-r--r--    1 root     system         1926 Sep 17 15:00 migrateSchema.bat
-rw-r--r--    1 root     system         2232 Sep 17 15:00 migrateSchema.sh
-rw-r--r--    1 root     system         1509 Sep 17 15:00 upgradeSchemaTables.bat
-rw-r--r--    1 root     system         1270 Sep 17 15:00 upgradeSchemaTables.sh

 

  1. Copy the dbscripts directory to the server that hosts your databases.
  2. Log in to your Deployment Manager administrative console and verify that the Business Space applications have been deployed, as shown in Figure 2.

    Figure 2. Verify Business Space application deployment
    Verify Business Space application deployment
  3. Also in the administrative console, verify that the JDBC resources have been defined, as shown in Figure 3.

    Figure 3. Verify that JDBC resources are defined
    Verify that JDBC resources are defined

 

 

Step 4: Configure the database

  1. If you didn't already do so, copy the dbscripts files to your database server.
  2. Log in to the database server using an ID authorized to create databases.
  3. Run the configBusinessSpaceDB script using the createDB option to automatically create the database:
    /home/db2inst1/scripts/BSPACE> ./configBusinessSpaceDB.sh createDB. You'll be prompted to provide the user ID and password of the database manager.
  4. To apply the changes, restart each of the WebSphere Application Servers on which Business Space is running.
  5. After restarting the Application Servers, you should notice that all the Business Space applications are now running in the administrative console, as shown in Figure 4.

    Figure 4. Business Space applications running in the console
    Business Space applications running in the console

This concludes the configuration process for Business Space. You can now log in to your business space and utilize the Business Events widgets. The standard location to log in to Business Space (assuming Security is not configured) is http://hostname:9080/mum/resources/bootstrap/login.jsp

 

 

Troubleshooting

Following are some potential errors and recommendations for how to correct them.

Errors during augment step

Error:
<message>[C:\Program Files\WBE701\WAS\profileTemplates\BusinessSpace\dmgr.bspace] is not a valid profile template.</message>

Solution:
Ensure that your path name is correct and the dmgr.bspace template is present.

Error:
<message>Current mode is:augment. It is possible that the augmenting template(s) being applied to [WbeSrv01] have already been applied or that the profile WbeSrv01 does not exist.</message>

Solution:
Verify that the BSpace_DB2-distributed.properties file has been modified to accurately represent your environment.

Errors during the install business space components step

Error:
WASX7015E: Exception running command: ">$AdminTask installBusinessSpace {-clusterName myCluster}"; exception information: com.ibm.bsf.BSFException: error while eval'ing Jacl expression

Solution:
Verify that the cluster name specified is correct and has been created without any issues. Verify that the cluster starts without errors.

 

 

 

Conclusion

You've now learned the detailed steps required to augment a Business Space in a WebSphere Business Events clustered environment!
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Introduction

This article describes some of the common interaction patterns that are seen when using synthetic events in a WebSphere Business Events project.

 

 

 

What are synthetic events?

A synthetic event is an event that is generated by WebSphere Business Events itself and is fired from an interaction set in the same way as an action. Other interaction sets can then be created to process the synthetic event.

In versions prior to WebSphere Business Events V7.0.1.1, when a synthetic event is fired, it is put on the JMS queue, or topic, and processed in the same manner as any other external event. This implementation has performance impacts because each synthetic event must be retrieved from the JMS and processed.

For WebSphere Business Events V7.0.1.1, the synthetic event process has been redesigned so that the event is processed immediately and is no longer re-queued. This new design does not have the same performance implications as the original design.

 

 

 

Why use synthetic events?

A synthetic event can be used in an interaction in many ways, but following are a few of the more common implementation patterns.

Simplify interaction logic

Reduce complexity of interactions by executing pre-filtering/screening logic on the inbound event. If the event passes the screening and is a candidate for further processing, a synthetic event can be fired. Interactions can then be written to operate on the synthetic event with the knowledge that the event has already met the conditions of the pre-screening logic.

Populate a context-sensitive intermediate object (CSIO) array

The CSIO may be required to contain data only for events that meet certain criteria. To facilitate this, an interaction is typically written to do a preliminary filter of the event and invoke a synthetic event, which can then update the contents of the CSIO array as appropriate.

Administer a context-sensitive summary object

When using a summary object, it may be necessary to reset the content of the summary object based on certain rules which can be defined within an interaction. By creating an interaction that dentifies when the summary object needs initialization, a synthetic event can be invoked and the summary object initialized using a simple JavaScript.

Create a common interaction for multiple event sources

In this case, events are received from different sources but a common set of interaction rules can be applied.

Reroute an event

In the case where events from an event source require processing independently, you can reroute the events to different synthetic events.

 

 

 

Sample interaction patterns

The following sections describe the sample interaction patterns in more detail.

Simplify interaction definitions

Sample scenario:

An event message contains an array of customer data from which you need to filter the event with different logic depending on the type of customer. The customer type is identified in the array by a field called CustomerType. There are several types of customer that need to be identified and then different complex logic needs to be applied to each type.

Possible Solutions

Depending on the complexity of the event data and the requirements for the action content, the recommended option is typically to use multiple interaction definitions, which contain the collection of filters required. The filters should be granular in design and reused within other filters to enable for reuse of the filter definitions.


Figure 1. Interaction with multiple filters in series
Interaction with multiple filters in series

Where complex event or action data is required, a better solution might be using synthetic events to filter the initial data and route to a new interaction set. Using this solution, you can often pass just the relevant portion of the array to the synthetic event, which makes the logic to process the event much simpler.


Figure 2. Solution using multiple synthetic events
 Solution using multiple synthetic events

A third option could be to reuse the same synthetic event. This pattern can be implemented where the filter rules for each customer are the same or are defined by the content of the event.


Figure 3. Solution using a common synthetic event
Solution using a common synthetic event

Populate a context-sensitive intermediate object (CSIO) array

A CSIO array is used to collect and store the content of multiple events within the same context ID. This data is stored in memory, which can lead to a high overhead of memory utilization for your implementation.

The CSIO array can only store event data, and you typically want to limit the amount of data you store in the CSIO array to limit the memory overhead. To do this, it is recommended that you use a synthetic event that filters the relevant data to an intermediate object, which is defined to capture the array of event data within the context.


Figure 4. Solution using synthetic events with a CSIO array
olution using synthetic events with a CSIO array

Administer a context-sensitive summary object

The summary or state data from multiple events can be shared across events in a context by placing it in an intermediate object that is configured to be a summary instance intermediate object. There is only one instance of each summary instance intermediate object, and its contents can be updated at event arrival time, but prior to the execution of filter logic within the interaction

In order to reset the summary content based on filter logic, a synthetic event can be fired when the appropriate conditions are detected. This synthetic event can then be used to reset the content of the summary event using JavaScript.


Figure 5. Solution using synthetic events with a context-sensitive summary object
Solution using synthetic events with a context-sensitive summary object

Create a common interaction for multiple event sources

In this scenario, events are received from multiple event sources (App1, App2, and App3), but need to be processed by a common set of rules within the same context. An interaction is created to consume each event source and map the appropriate data to a common format, then a common synthetic event is fired from each application. Another interaction is defined, which consumes the synthetic events and process against the common filters.


Figure 6. Common interaction for multiple event sources
Common interaction for multiple event sources

Reroute events

There are many scenarios in which you need to reroute an event source and process the events independently of each other. One example of this is when an event source contains events that may require processing by multiple interactions. In most cases, creating multiple interactions with unique filters is sufficient. In the case where a context ID is required for an interaction, but not for all interactions from the same source, it maybe beneficial to precede the interaction processing with a “router” interaction, which can route the events to distinct synthetic events. This allows you to process the events for context-related interactions and plain interactions independently and avoid any costly overhead required for the contexts for all events.


Figure 7. Rerouting events
Rerouting events

 

 

 

Conclusion

In this article you learned about several patterns that utilize synthetic events to address various requirements within a WebSphere Business Events project.
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